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1 Product Overview

This chapter gives an overview of Active@ Boot Disk

1.1

About Active@ Boot Disk

Active@ Boot Disk is a powerful set of tools engineered to help you in a number of data
recovery and data security situations.

Active@ Boot Disk combines a number of powerful tools that let you recover lost data,
reset Windows passwords, make computer system backups and securely erase data.
Active@ Boot Disk starts when you start your computer from a boota ble COYDVD/BD

Disc or USB Flash Media

Active@ Boot Disksuggests a customizable user interface. You can create shortcuts for

the additional portableus er 6s t ool s on the Desktop and
as you do it in Windows Desktop environment. These shortcuts can be saved to USB

media and restored when you boot up the system the next time even on the different PC
configuration. Network Settings, current Display Resolution and Scale can also be
customized and stored to USB the same way.

When you use Active@ Boot Disk, you gain access to the drive's data on a physical level,
and on a logical level, therefore bypassing the resident operating system. This allows

you to lock selected volumes for your exclusive use. Locking a volume is important if you
want to wipe the data residue from an unoccupied space onthedrive, cr eat e a
data backup or recover files or folders located on your system volumes.

When you boot from the local hard drive, the operating system is not capable of locking
the existing volumes. The recovery operation must have exclusive access to the target
location. Otherwise if a service or another application gains access to the target location,
it might write over the files that you are trying to recover, renderingt hem un-
recoverable.

Here are some other functions that you can perform with Active@ Boot Disk by booting
from the CD/DVD/USB:

1 Backup the system drive - If you back up the system drive with Windows
running from the same drive, when you restore the backup, i t will start as
though you are recovering from a loss of power since the boot up will start
with system integrity checking. If you back up the system drive with
Windows running from an external drive, the restored system will start
without any pit stops.

1 Wipe unused data from the system records and directories, from MFT (on
NTES) from unused clusters, from file slack space (see Active@ KillDisk) A
"clean" wipe operation is not possible if the Windows is running from the
same drive that you are trying to wipe the data from. If you wipe the data
with the Windows booted from an external drive, itwillbe a A ¢ Iwpa n 0

1 Delete filesi Deleting data with Windows running from the system drive can
be unreliable, especiallyif the Volume Shadow Copy is running in the
background. Volume Shadow Copy service may still be active,keeping the
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1.1 About Active@ Boot Disk

previous version of the file or even a snapshot of the whole disk. With this in
mind, an intruder might try and retrieve your confidential data. By deleting
your files using the other operating system from an external drive, you can
rest assure that the deletion is permanent.

Active@ Boot Disk contains the following products and utilities:

= =4 4 -4 -4 -4 -—a A _a -»

Active@ Disk Image

Active@ Data D/DVD Burner
Active@ Partition Recovery
Active@ File Recovery
Active@ Password Changer
Active@ Disk Editor

Active@ KillDisk

Active@ Partition Manager
Active@ BCD Editor

Network operations utilities to help you map network drives, view network
status, configure IP settings and Windows firewall and to help you connect
and work with a server remotely

Utilities to monitor the status of your hard disk, copy, move and delete files
and folders, extract compressed archives, create text file s, preview an image
or graphics and search for and display registry details

System utilities to create, delete, format and resize partitions, manage
system tasks, run command prompt commands, check disk integrity and
defragment volumes, display system information, configure the display
parameters and edit system boot configuration.

Internet tools: Internet browser and Mail Sender
Console Tools: Command Prompt, DiskPart, DiskRAID,FTP Cliens

Professional Tools: PowerShell, BitLocker Manager & Repair tool, iSCSI
Manager, SSH & Telnet clients

A list of documents that support Boot Disk utilities .



1.1.1 About Active@ Boot Disk  operating system

Because the Active@ Boot Disk ISO image has been created using the Microsoft
Windows PE (Preinstallation Environment) operating system, you have access to many
new Windows 11 (24H2 code base) features.

Active@ Boot Disk can be targeted for different platforms:

1 64-bit Intel or AMD processor (x64 or amd64 architecture)

1 64-bit Snapdragon processor (arm64 architecture)
The bootable image contains a variety of plug-ins, drivers and other 64-bit applications.
Here are some features of Windows PE

1 Youcan use the new Windows 11 style standard dialogs, like File Open, Save
As, and so on.

1 PnP (Plug and Play) support: Hardware devices can be detected and installed
while Windows PE is running. This supports any in-box PnP device, including
removable media and massstorage devices. This means that you can plug in
a mass-storage device to use for data recovery or data backup.

1 Automatic writable RAM volume: When booting from the CD/DVD drive,
Windows PE automatically creates a writable RAM disk (drive X:) and
allocates 512 MB of the RAM disk for generalpurpose storage. By using
compressedNTFS, the512 MB is addressable up toalmost 1GB This drive
space may be used to recover files or folders.

£

-'-j Note There are two Active@ Boot Disk packages beingdistributed. One is a
public evaluation DEMO that can be also activated with a registration k ey.
DEMOpackage contains a standard WinPE11 set of packages This is a
minimal size configuration. Another package has been supplied to clients
after purchasing a registration key. This full package contains additional
packages installed: WinPENetFX (NET Framework), WinPEDot3Svc
(IEEE 802.X authentication protocol on wired networks), WinPE-RNDIS
(network support for devices that implement the Remote NDIS
specification over USB), WinPEPowerShell (PowerShell console), WinPE
StorageWMI (PowerShell cmdets for storage management), WinPE-
Scripting (multiple-language scripting environment for automating system
administration tasks, such as batch file processing), WinPEWMI (subset
of the Windows Management Instrumentation providers that enable
minimal system diagnostics), WinPESecureStartup (provisioning and
management of BitLocker and the Trusted Platform Module - TPM),
WinPEEnhancedStorage (enables Windows to discover additional
functionality for storage devices, such as encrypted drives, and
implementations that combine Trusted Computing Group (TCG) and IEEE
1667) . It requires ~150MB more disk storage space and consumes
~150MB more RAM when boot up than the smaller package
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1.2 Requirements for Using Active@ Boot Disk

#

-ﬂ Note After the Windows PEoperating system and Active@ Boot Disk have
started, the boot CD/DVD can be removed from the drive. A new CD/DVD
can be inserted into the drive and you can read from it or burn data to it.

1.2 Requirements for Using Active@ Boot Disk
To use Active@ Boot Disk, you must have the following:
1 64-bit Intel or AMD processor (x64 or amd64 architecture)
1 64-bit Snapdragon processor (arm64 architecture)
 1GBor more RAM
1 A CD/DVDBIlu-ray drive or a USBmass storage deviceto boot from

In addition to the above, you must be able to start the computer and you must have
access to the system board BIOSUEFI setup to specify bootable device.



1.2.1 How the system RAMis used

The ISO for Active@ Boot Dik was created from Windows PE (Preinstallation
Environment), a lighter version of Windows 11.

When booting from the CD/DVD drive or from a USB storage device, Windows PE
creates a writable RAMvolume (X:) and places itself in this drive for loading. While
Windows is booting up, it loads itself into RAM. After Windows has started, the boot
CD/DVDmay be removed from the drive or the USB flash card may be removed from
the USB port Starting with 1GB of RAM, all that is left is about 500MB of available space
to work with.

1.3 Download ing and Creating Active@ Boot Disk

You must perform these operations on a separate computer with a healthy hard drive
and access to the Internet.

To download Active@ Boot Disk:

1 Open your browser and navigate to http://www.boot -disk.com

1 You candownload either package for Intel/AMD processor (x64/amd64) or
package for Snapdragon processor @rmé4)

To download the evaluation Demo version, click the Download link.

To download fully featured Active@ Boot Disk click the Buy Now! link and
follow the procedure for paying.

1 You can save the file to a folder on your machine or you can run it directly
from the Internet folder.

1 Run the installation executable and the install wizard will lead you through
pages in order to agree with the terms of the license and determine the
destination folder.

1 Inthe Select Components page, for assistance with writing Active@ Boot
Disk to a bootable CD, DVD or USB mass storage device, select theActive@
Boot Disk Creator check box.

1 After Active@ Boot Disk has been successfully installed, select theRun
Active@ Boot Disk Creator  check box and click Finish .

Continue with the next section.
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1.3 Downloading and Creating Active@ Bod Disk

1.3.1 Active@ Boot Disk Creator

Active@ Boot Disk Creator Felps you prepare a bootable CD/DVD/Blu-ray disc, ready-to-
go ISO image or USB Flash mass storage device that you can use to start a machine
with a damaged hard drive and recover data, recover partitions, wipe or erase data,
create a disk image or repair security access issues.

To prepare a bootable device for Windows:

1. Inthe Active@ Boot Disk Creator main page, select the desired bootable media:
CD/DVD/Bluray, USB Flash Driveor pre-configured ISO Image file (can be used
with Virtual Machines like VMWare or HyperV, or can be burned to CD/DVD/BD
later on):

L

Acrive@ Boot Disk

Active@® Boot Disk is an utimate data recovery toolset on removable media, being able to boot your computer and backup/recover/inspect or erase your data
even if pre-installed Windows or Linux does not boot. Supported legacy BIOS boot mode as well as the latest UEFI secure boot on x64 (64-bit) architectures.
Active@ Boot Disk includes the latest driver packages, being able to recognize and work properly with nearly all the latest computer hardware configurations.
This wizard helps to create a bootable disk on USB/CD/DVD/Blu-ray or pre-configured ISO image for using with Virtual Machines ke VMWare or Hyper-V.

Steps to the disk creation process:

1: Selecting Media
2. Selecting Target & Configuration
3. Finalizing & Writing to Media

Step 1: Select Media

CD/DVD/Blu-ray
O 150 Image
@® USB Flash Drive VendorCo ProductCode (E:) [Removable Media 3.75 GB] z
Licensed to: DEMO Version
Registration Update Help About LSoft Technologies Inc. 2024 © All rights reserved

1 If more than one CD/DVD burners exists, or several USB disksre inserted,
select a proper device from a combo-box. If your USB Disk is not displayed in
a combo-box, click the link below and initialize it properly. If you have
purchased commercial versionof Active@ Boot Disk, clickRegistration link
to register software on your name or on the name of your business.
Registration eliminates DEMO version limitations and activates all features of
commercial software.
Click Next .



10

&) Bootable Disk Creator [Active@ Boot Disk v 25.1.0] x

Active (@) Boot Disk

Target System Boot Settings User's Files Add Drivers Startup Scripts Application Startup Cloud Settings App Config

Operating System

WinPE 64-bit

¥ Windows-based Boot Disk
®) Boot Disk for Intel/AMD (x54)
Boot Disk for Snapdragon (Arm64)

Graphical User Interface

Active T Boot Disk
Linux-based LiveCD/LiveUSB et ks
o = TinyCore 32-bit & 64-bit
Console-based Boot Disk Cooe Uae 1
0.00GB 10.00GB 20.00GB 30.00GB 40.00GB 50.00GB
e System Files BN User Files W Free Space . Over limit 746.89 MB

1 Make sure that Windows -based B oot Disk checkbox is selected
1 Select proper platform (Intel/AMD or Snapdragon) to prepare boot disk for
At this step you can specify additional options:

a. To specify additional boot options, click System Boot Settings tab. You
can change default settings to be used: Time Zone , Additional
Language Support, Display Resolution and Scale , Default
Application Start  and Auto -start Delay .

Active (@) Boot Disk

Target System Boot Settings User's Files Add Drivers Startup Scripts Application Startup Cloud Settings App Config
These opti ilable for d & Linux GUI editions only

General  Network  Security
Additional Language and Keyboard support Time Zone

None v (GMT-05:00) Eastern Time (US & Canada) >
Display Settings

Resolution Auto-detection X

Scale Recommended X
Default Application

Start Off ksl

Time to Autostart

Seconds |30 =
0.00GE 10.00GE 20.00GE 30.00GB 40.00GE 50.00G8
o System Files B User Fles e Fres Spacs . Over limit 673.84MB
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1.3 Downloading and Creating Active@ Boot Disk

Two additional second level tabs:

a. Network tab allows you to pre-define Network Settings: network
initialization, dynamic or static IP configuration and firewall state.
Subtab Network Resource  allows mapping a network resource
to a volume letter to be able to export reports and other data.

b. Security tab allows you to set up a Boot Disk password
protection for boot up process to avoid unauthorized Boot Disk
usage.

To add your custom files to boot able media, click User 6 &iles tab. Add
files or folders using related buttons at the right side. Added items will be
placed to User_Files root folder.

To add specific drivers to be loaded automatically, click Add Drivers tab.

Add all files for the particul ar dri ver (*.I1INF, *.SYS,
be placed into BootDisk Drivers  root folder. At boot time all *.INF files

located in this folder will be installed.

D~
~

To add specific scripts that will be launched after Active@ Boot Disk is
loaded, click Startup Scripts tab, add your scripts (*.CMD files). Added
files will be placed in BootDisk_ Scripts root folder. At boot time all
*.CMD files located in this folder will be executed.

To specify default application startup parameters, click Application

Star tup tab and type command line parameters. Note, that this tab will
be enabled only after you define Default Application  to be started at
System Boot Settings  tab.

To configure access to clouds for applications that use Cloud Services (like
Active@ Disk Image), click Cloud Settings tab and type all related info.

To configure settings for particular applications, click App Config tab and
type all related info. Sub tabs let you select the particular product.

Settings accessible forActive@ KillDsk:

- Settings file path T local/network path to a pre -configured
settings.xml file to be used as current settings

- Digital signature  path i local/network path to *.pfx file to be used
for digital signing erase certificates

- Logofile path il ocal / network path to companyads
be used for erase certificates

- Volume label to store reports i local or network attached volume
(logical disk) with particular name, where certificates/events/reports
will be stored after erase is complete

- Mapped network resource to store reports T if network resource
has been configured and mapped to a drive letter, it can be used to
store all reports/logs/certificates

Most of these options you can change later, after booting from Active@
Boot Disk drive, at the opening screen. Since Active@ Boot Disk is comes
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with ot her L Sdefauli Appliaation bption allows gon to
skip launching that default application particular. This is also applicable in
other Active@ Boot Disk Lite versiors being distributed in other Active@
software products, like Active@ KillDisk for example.

Click Next . Verify the Selected Media, Sizes and Bootup Environment.

If you prepare Active@ Boot Disk WIM image for use with PXE Boot, click
Save button store your custom configuration. Place saved files to the root
folder of WIM using DISM utility from Microsoft ADK

1 ClickCreate . A progress bar appears while media is being prepared.

£

f-ﬂNote USB Drive or blank CD/DVD must be insertedand chosen explicitly on the
first step, before you can proceed to the next step .

—

E-ANote When you prepare USB Flash Drive bootable media, it will be re -
formatted, thus all data stored on the media will be erased. If your USB
Disk is not displayed in a combo-box, click the link below and initialize it
properly. The only 32GB or less size partitions supported (for best
compatibility with all types of BIOS & UEFI Secure Boot systems), so if
you have 64GB USB, initialize it with the only 32GB partition.

—

f-ﬂNote I f youo vI8O Image afite,eyau can burn it up later on, either
using our free Active@ I1SO Burner utility (www.ntfs.com/iso -burning.htm),
or have a disk burning utility that you prefer to use .

1.4 BootDisk Driver s and BootDisk Scripts

You can automate some functions using Active@ Boot Disk.

While Active@ Boot Disk is starting, you may install drivers and run scripts in order to
reduce the amount of time required to perform maintenance functions on your data
storage system.

If you know that your hard drive has damaged drivers, or if you have o Ider or
uncommon RAID type or SCSI type drivers, you can create a folder named
BootDisk_Driver s in the root of any logical drive and load drivers along with their
configuration files into it. Active@ Boot Diskwill detect these drivers and install them
automatically during the boot process.

While Active@ Boot Disk is loading (described in the next section, below), the utility
searches for the BootDisk_Drivers  folder in the root of all devices. That includes the
floppy drive, a USB device, a working hard drive, and so on.

If Active@ Boot Disk finds .INF files inside a folder named BootDisk_Drivers it tries to
load them along with all other files required by the driver s.
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1.5 Booting from a CD, DVD or USB Device

Whether or not the utility loads drivers, Active@ Boot Disk will proceed in search of a
folder named BootDisk_Scripts i again in the root of any logical drive. Active@ Boot
Disk will run any CMD files, assuming that they are scripts.

Active@ Boot Disk Creator helps youin configuring these folders.

£

-ﬁ Note Active@ Boot Disk Lite version (induded in other Active@ software
packages, like Active@ KillDisk) launches a primary application by default
without any command line parameters. If you need to configure a default
application to be run with some command line parameters, you need to
create a proper script and place it in the BootDisk_Scripts  folder. In
this case we recommend you to turn off default application launch ( Boot
Settings tab in Boot Disk Creator) to avoid two copies of software being
launched after boot disk start up at the same time.

1.5 Booting froma CD , DVD or USB Device

You can start your computer and perform data recovery and other functions by startin g
from a bootable CD, DVD or USB device

To start your computer with the Active@ Boot Disk CD, DVD or USB device you must
first download the ISO file and burn it to the medium.

Before you use Active@ Boot Disk, you must purchase it and obtain a registration key,
or use supplied evaluation DEMO key

£

-ANote For instructions on setting boot sequence priority in the system BIOS, see
Chapter 4: About Boot Priority.

To boot from the Active@ Boot Disk device:

1. To boot from a CD or DVD, put the bootable Active@ Boot Disk CD or DVDdisk
into the player.

I To boot from a USB device, plug the bootable Active@ Boot Disk USB
device into a USB port.

9 Start the power on the machine. In a black text-mode screen, the following
message appears:

Press any key to skip loading Active@ Boot Disk

1 If you want to cancel booting up the Active@ Boot Disk and load the
operating system on the hard drive, p ress a key on the keyboard. Otherwise
the screen will change and loading of the kernel will appear .
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1 After the Windows PE start screen, the screen will go dark for a period of
time. Wait for the start page to load.

1 The Active@ Boot Diskstart page appears.

Active @ Boot Disk

Wl Additional keyboard layout:

ut to install: PR (French)

1 If you stay idle on this page, after the 30 -second progress bar completes,
Active@ Boot Diskwill automatically continue.

1 On this page you can change and add these features:

a. Add a second language keyboard layout- select the Additional
Keyboard layout check box and choose the language from the
Keyboard layout to install drop-down list.

b. Changelocal time zone- choose the time zone from the Time zone
drop-down list.

c. Changescreen resolution- choose a setting from the Screen
resolution drop-down list.

d. Initialize your network card and allow a network connection, select
the Initialize network interface check box.

e. Click OK.

The console will detect and load hardware drivers and start the network connection (if
you have initialized the network interface) . This may take a long time and the screen
may have black flashes.

1 The Active@ Boot Disk taskbar appears.

14 Active@ Boot Disk User Guide



1.5 Booting from a CD, DVD or USB Device

You are ready to use the utilities in Active@ Boot Disk.

After starting the computer this way, you will have full and exclusive access to the
system drive. With this kind of access, you can perform tasks that are not possible when
Windows has been booted regularly from the hard drive.

The only other way to get this type of exclusive access to your hard drive would be to
physically remove it and install it on another computer.

—
-ﬂ Note You cannot save registration information to a file on a hard drive with
damaged partitions.

—

-:ANote If you have successfully booted from the CD, DVD or USB deviceand you
do not see your C: drive because, for example, it is a Stripe Array (RAIDO)
or if you are using an older or non -standard controller, see instructions in
Start > Load Driver.
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2 Navigating the Active@ Boot Disk Shell

The Active@ Boot Disk shell works in a way that is similar to the Microsofté #indows
shell. The main interface of the shell appears as a taskbar at the bottom of the screen.

As in Windows, Start button, with the Active@ symbol on it, can be found in the bottom
left corner. Several quick launch iconsare placed on the right of the Start button.

2.1 Start button menu

@ About Boot Disk

I Programs

¥ Network

[ Utiities

‘B System

T Internet

™ Console Tools
% Documentation

User Programs

@ Run...
% Load Driver
) Turn Off Computer

‘@‘ S P BO

The Active@ Boot DiskStart button is the central launching point for applications ,
utilities and support documentation. To access one of the applications or utilities, click
the Start button. A menu will appear containing shortcuts to applications, utilities and
documentation under the following headings:

16

9 Programs i Data backup, data recovery and data security programs that allow

you to:

V  Back up or restore physical and logical hard drives, including folders, data
files and installed applications. Use an ISO disk image or burn files to a CD or
DVD. Protect your valuable data by regularly making backups.

<

Recoverfiles from deleted or damaged partitions on attached or external
drives, portable drives and memory cards.

Recoverdeleted or damaged partitions and volumes.
Reset password and user accounts on your system.

View and edit disk sector content in raw format.

< < < <

Securely erase data from hard drives in a way that it is impossible to restore
the data.

Active@ Boot Disk User Guide



V Wipe data from unused clusters on a regular basis to make your drive's
deleted or temporary data unavailable to intruders.

V  Monitor the reliability status of your local hard drives to help prevent data
loss due to hard drive failure.

Network 1 Network operations utilities to map network drives, view network
status, renew your computer IP address or connect to a remote desktop

Utilities T Monitor the physical status of your hard drives, create, delete and
format drive partitions ; copy move and delete files and folders and edit registry
parameters. Search for and display registry details. Also make calculations, notes
and graphics about actions that you have done or need to do

System 1 Run system dtilities like Windows Task Manager, Partition Manager
and Check Disk. Run commands in a DOSenvironment. View & edit BCD
(Bootable Configuration Data) entries. Allow menus and dialogs to display in local
languages and change the keyboard layout. Also, display system information,
change the display resolution and scale

Internet T Run Internet browser and send emails

Console Tools i Run command line tools, like Command Prompt, DiskPart, FTP
Client, Telnet and more

Documentation 1 Documents included with Active@ Boot Disk

User Programs 1 Shortcuts created by users will be placed here as well as on a
Desktop. If you store customized configuration to the USB disk while shutting
down the system, the configuration will be restored when your next boot

17



2.1.1 Other start button features

Start > About Boot Disk

To get information about your purchased license or the status of your DEMO install, click
Start > About Boot Disk.

Start > Run
Use Runto launch a program from a command line.

@ren x
ﬁ Type the name of a program
Open: I | j
OK | Cancel | Browse... |

To start a program using Run:
1. ClickStart > Run. The Run dialog box appears.

2. In Open, type the path to the program you want to open, or click Browse to
locate it.

3. Click OK.

The Open drop-down list displays programs you have opened recently.

Start > Load Driver

Load Driver will help if you have SCSI drive controllers or an older or uncommon RAID
type device. Load Driver will also help if you cannot find any other type of driver, for
example, video driver, sound card driver, etc.

To load a driver:
1. Click Start > Load Driver. The Active@ Driver Installer dialog box appears.

1 In INF Path, enter the path to the driver information file or click Browse to
locate it.

1 ClickINSTALL DRIVER!

After the driver is installed, you should be able to locate the driver using Utilities >
Explore My Computer. Similarly, the system should be able to locate and use the driver.

E
-: Note If you do not have the driver information file on the current drive, do one
of the following:
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9 Load a CDor DVD disk with the correct drivers into the CD /DVD drive
or plug a USB device with the correct drivers into a USB port.

9 Close Active@ Driver Installer. Use Internet Browser or another
Internet utility to download the driver from an Internet URL and save it
to your hard drive. Start this procedure again at step 1.

S
-ﬁ-ﬁNote You can load drivers automatically at boot time. For more information,
see 1.4 BootDisk_Drivers and BootDisk_Scripts

Start > Turn Off Computer

When you turn off the Active@ Boot Disk shell, you have the option to shut down your
computer, restart it or cancel the exit routine.

2.2 Quick launch icons

Several permanent icons appear to the right of the Active@ Boot Disk start button. To
see a nhov e rditidna infarmatian tiblout a quick launch icon, hold your
mouse pointer over the icon.

[
@ Pl RO BEO®YO

Use these icons to conveniently open the following programs:
1 Active@ Disk Image

Active@ File Recovery

Active@ Partition Recovery

Active@ Password Changer

Active@ Parition Manager

Active@ Disk Editor

Active@ KillDisk

Active@ Data CD/DVD Burner

Active@ Disk Monitor

= =4 4 -4 -4 -—a -a -2

E

-: Note To allow the taskbar to hide automatically, click the lock icon to
unlock it. The taskbar hides until you hold the mouse pointer over the
bottom of the screen. To lock the taskbar in place, click the lock icon to
lock it.
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2.3 System utility

icons

At the bottom right corner of the taskbar, a system tray is placed with a clock showing
the system time and date.

As well, severalicons provide quick access to system utilities. T 0

see

a

fihover

additional information about a system utility icon, hold the mouse pointer over one of

the icons.

Use these icons to conveniently open these utilities:

1
1
1
1
1

Set Date, Time & Zone (You may also double-click the clock.)

Display Settings
Task Manager

Explore My Computer

Screenshot utility

If a network is installed, the Network connection icon displays full configuration details
such as operational status, IP address, DNS server address, firewall shtus, and so on.

If a second language is installed, the current language is displayed, along with a hint

about how to change the active language.
After you have successfully started Active@ Boot Disk, clickUtilities > Explore My

Computer . The Boot Disk Explorer will appear. You should see all the physical and

logical devices associated with your computer along with the RAM drive Boot (X:).

Display Settings

This utility allows to change current Display Resolution and Scale to provide better

desktop look and feel.

List of valid modes

or (32 bit), 64 Hertz

bit), 64 Hertz

r (32 bit), 64 Hertz
720 (32 bit), 64 Hertz
720 r (32 bit), 64 Hertz
800 by 480, True Color (32 bit), 64 Hertz

Scale
Current: 100 %

100 % e

To change Display Settings:

1. Select desired resolution in the List of valid modes
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and click Apply .
2. Select desired Scale in the list of Scale options and click Set.
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In seconds display should be resized to accommodate new parameters. If for some
reason Windows was unable to change resolution or scale, previous mode will be
restored.

Screenshot

This utility is an easy-to-use, flexible way to take a snapshot of on-screen details in the
Active@ Boot Disk environment.

To use Screenshot:

9 Click the Screenshot icon. The Screenshot workspace will appear as a
semi-transparent overlay.

1 Change the size and location of the workspace. The area that is covered is
the area that will be captured.

1 When you change the size and the location of the workspace, the Top
and Left values change to identify the location of the top left corner of
the workspace. At the same time, the Height and Width values
change to reflect any change in the size of the workspace.

1 To change the size of the Screenshot workspace, click anddrag an
edge or a corner of the workspace.

1 To change the location of the workspace, click anywhere on
Screenshot and drag to a different location.

9 To fill the entire screen, click Maximize .

1 With the Screenshot workspace in place, you can return to the orig inal
application using ALT+TAB keyboard combination.

1 You can also click the original application to return to it, however if you
click an area of the application that is covered by the Screenshot
workspace, the focus will return to Screenshot.

1 To capture the screen image, in Screenshot, clickGrab and a semi-
transparent image of the screen will appear on the desktop

1 To clear the existing screen image, click Clear .
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I To save the screen image, click Save and navigate to the folder where you
want to save the image. You can save the image as PNG or BMP

2.4 Desktop Shortcuts and User Programs menu

Active@ Boot Diskallows to customize the user interface. You can create shortcuts for

the additional portable userbd6s tool seway t he Desk
as you do it in Windows Desktop environment. These shortcuts can be saved to USB

media and restored when you boot up the system the next time even on the different PC

configuration. You can store customized settings to USB even if you boot from CD/D\D.

To create a Shortcut:
1. Right-click the Desktop and click Create Shortcut context menu item

2. Select path to the application executable in the Path: field and type shortcut title
in the Description : area

3. Select where you want shortcut to be stored:

a. on the Desktop

b.in the User Programs sub-menu of Start menu

c. in the specific folder, select full path to the desired location
4. Click Create button

# Create Shortcut EI@

Path: |!{:‘|,ProgramFiIes\,BDOTDISK‘n,Eprorer.exe |

Description: |Exp|orer |

Destination
# Created
Desktop p—
Shorteut created.
Start Menu
(] Spedify path

Create

To store customized settings including shortcuts to USB:

1. Click Turn Off Computer  from the Start menu
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2. Selectsettings you want to save. Settings not being changed are grayed out

3. SelectUSB volume to save settings to

¥% Save Changes

Active@ Boot Disk DEMO

0 14

Do you want to store customized Boot Disk settings and shortouts to USB?
If you save to USE, you can restore the settings next time you boot any PC when USB is inserted.

Metwaork
Display Resolution
Start Menu

Desktop

Available Volumes
E: fACTIVE BOOT) on Generic Flash Disk

2]
€
[
2}
Free Space
3G8 &

Sawve

4. Click Save button and proceed with Shut Down or system Reboot
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3 Programs and utilities

This chapter provides detailed descriptions of all the programs and utilities included with
Active@ Boot Disk.

Applications are listed in this chapter in the order that they appear in the Active@ Boot
Disk start menu.

@ About Boot Disk

Actve@ Dk Image
@ Active@ Data CD/DVD/Blu-ray Burner
= Active@ Partttion Recovery

o Network

@ Utilties

B System

B Games

T Internet

& Documentation

@® Run...

@ Load Driver

&) Turn Off Computer

3
3
3
3
3
3

o} Active@ File Recovery

B Actve@ Disk Editor

¥, Active@ Password Changer

® Active@ KilDisk

@ Active@ Partition Manager

[C] Active@ Disk Monitor

= &
‘@ Pl ROBO®@®0

3.1

Program s

3.1.1 Active@ Disk Image - Create an exact image of the data stored in selected
partitions of a hard disk or an image of the entire hard disk.

3.1.2 Active@ Data CD/DVD Burner - Write/burn files and folders onto CD-R, DVD
R, DVD+R, CDRW, DVDRW, and DVD+RW.

3.1.3 Active@ Partition Recovery - Recoverdeleted or damaged partitions located
on data volumes, attached hard drives, as well as on external USB drives and Memory
Cards (SunDisk, MemoryStick, CompactFlash, etc.).

3.1.4 Active@ File Recovery - Recover files that have been damaged, destroyed by a
virus or if the file directory has been destroyed.

3.1.5 Active@ Disk Editor -Edi t di skés raw data to analyze
(Master Boot Record) and other important files. Advanced search capabilities and
templates for viewing MBR, Boot Sectors, LDM, MFT records are available

3.1.6 Active@ Password Changer - Recover user accounts with forgotten or
damaged user passwords.

3.1.7 Active@ KillDisk
deleted data, securely removing all data in unoccupied sectors

- Destroy data permanently from any computer. Also, wipe

3.1.8 Active@ Partition Manager - Perform maintenance tasks on hard drive

partitions.

3.1.9 Active@ Disk Monitor - Monitor the reliability status of your local hard disk
drives to help prevent data loss due to hard drive failure.

24

Active@ Boot Disk User Guide

an



3.1.1 Active@ Disk Image

Active@ Disk Image is a Windowsbased solution that allows you to create an exact
image of the data stored in selected partitions of a hard disk or an image of the entire
hard disk. You can protect your valuable data by regularly making a disk image and
keeping it in a safe place. If you have trouble with data corruption, or if you want to
refer to an archived version of a file, you can easily restore the data.

The application provides many tools when it comes to backing up data on your hard
disk:

1 Diskto Image i Choosing this option will open the Disk to Image Wizard. It will
help you in creating a regular type of the disk image archive of an entire disk or
of selected partitions in the system.

1 Image to Disk i This option features Image to Disk Wizard which will enable you
to restore data from a disk image archive that you have previously created.

1 Explore Image i Enables you to browse through files and folders in a disk image
as though it was a hard drive. You can select folders or individual files and
restore them.

1 Verify Image - Verify Image Wizard is there to checking the integrity of the disk
image archive file.

1 Create Raw Imagei with its Create Raw Image Wizard this application will guide
you in creating a raw type disk image of only one patrtition or the entire disk.

1 Clone Diski Enablesyou in transfering a sector-by-sector copy from one disk
(partition) to another.

T Partition Manageri A tool that helps you create, delete, format or show
properties of partitions on all devices in your system.

This guide describes only the Disk to Image tool. For a description of the other tools,
see the Active@ Disk I mage Userb6s Guide document
Active@ Boot Disk shell.

Creating a Disk or  Partition Image

The Disk to Image Wizard steps you through the process of creating a disk image for a
whole disk or a number of partitions.

To create a disk or partition image:

1. To open Active@ Disk Image, in the Active@ Boot Disk shell, clickStart >
Programs > Active@ D isk Image .

I To open the Disk to Image Wizard, in the Disk Operations Panel choose Disk
to Image .
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¥ Active@ Disk Image Professional 6.0.3 - LSoft Ted =] 3
Fle View Toos Help

Disk Operations

Details - J L
Disk to Image Image to Disk ' Create Raw Image
% Disk to Image &y <
Cieate a Backup Disk Image 1 h Verify Image ] § Copy Disk to Disk
which can be used to rscover
your entire computer such as a ’
logical partition or a physical e
hard disk. Backup Disk Image () Explore Image
files contain used disk space =4

oy and may be spit inta
chunks, compressed, and/or Service Utilities

password protected
@ Partition Manager

Other Operations

L | ViewLog

Clone Disk

Ac_h’ve@
Disk Image

Ready

4

1 The wizard will ask you to choose one from three available backup types
x

Create a Disk Image

Keep Your Data Safe
Disk to Image Wizard helps you create & backup image of used sectors in selected
partitions or a whole disk. You may split the image into a series of files for convenient
storage.

Backup type

& Ful backup
¢~ Incremental backup

~ Differential backup

To continue, dick Next
Active ®
Disk Image

= Back I Next > I Cancel |

1 Full Backup represents an ordinary backup. If this is your first backup it
doesndt matter whi chbfirshpatkuposralwayoFRull c hoos e,
Backup .

1 Incremental Backup-i t 6s made out of Full Backup and
backups. It contains differences and changes between these two backups,
and the maincharacterist i ¢ of the I ncrement al Backup
require a lot of space but it does require the information from all of the
previous incremental backups in order to be functional.

9 Differential Backup- requires only the first (Full Backup) and the last bac kup.
There is no difference between Incremental and Differential backups if they
only have two backups (Full Backup+ another backup), the difference
becomes noticeable over longer periods of time when Incremental backup
generates more of its backups.

T Click Next , which will open Select Disks and Partitions window.
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Disk to Image Wizard n

Select Disks and Partitions o BN
Select the partitions and disks that you want to indude in the disk image bgl ]
Partition Flags Capacity Used space  Information
[] < pisko 223.6 GB INTEL SSDSC2CW240A3
[ % Local Disk (C:) Pri, Act 223.6GB 02.9GB NTFS
[ pisk 1 931.5GB SAMSUNG HD1035)
] Local Disk (F:) 93.3GB 28.8GE NTFS
] @)Local pisk (0:) 838.2GB 722.8GE NTFS
D B Disk 2 7.3 GB Kingston DataTraveler 2.0
] ®Local Disk (G:) Pri, Act 7.3GB 40GB NTFS
Totalsize: 0 bytes Refresh

Next > Cancel

T Select a check box next to a disk or partition that you want to be included in
the disk image. You can see at the bottom of the list the total size for the
selected partitions being displayed.

1 ClickNext and the Indicate Backup Location page will appear.

Disk to Image Wizard
Indicate Backup Location - 3
Enter backup name and the path or browse to the folder where you want to store this image E i

Backup to:

() CD/DVD burner

Device: TSSTeorp CDDVDW SH-5223C SBOS (E:) Settings...

Backup name: DiskImage

(®) Local or netwaork file

Backup name: iz

Location: D\ v Browse...

<« Back Cancel

1 Do the following:

1 If a CD/DVD burner is available, select the CD/DVD radio button, select
a device from the Device drop-down list and type an appropriate disk
image name into the Backup name field.

1 To save the disk image to a hard disk, select the Local or network
file radio button and click Browse... and navigate to the location
where you want to save the disk image.

1 ClickNext . The Image Options page appears.
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Disk to Image Wizard

Image Options )
Set options for data compression and other image parameters g &ﬂl
Compression Password protection
(O None Password
(@) Mormal (recommended) Confirm password
(") High 8
-/ TG Encryption None
Image splitting Image description
(@) Automatic (try single file)
() Fixed size (MB)
Create separate image for each disk
edit names)

< Back Cancel

1 Do the following:
9 To set the compression ratio, select one of the three options:

- None give you fast results and a larger file size.

- Normal (recommended) is a compromise between a smaller file
size and a faster operation speed.

- High provides the smallest file size and takes the longest time to
complete.

1 To try saving the disk image to a single file, in the Image Splitting
area, select the Automatic (try single file)  option. If the system
runs out of free disk space on the disk where you are saving the
backup - or if you ar e storing an image file on disk with a FAT file
system - Active@ Disk Image automatically will split the archive into
multiple files and prompt you to add another path in order to continue
writing the rest of the file .

1 To manually indicate how to split the disk image, in the Image Splitting
area, select the Fixed size (MB) option and type a file size in
megabytes or choose a sizefrom the drop -down list.

1 To protect sensitive data on a disk image, in Password , type a
password (maximum 16 characters) and type the same password in
Confirm .

1 Optionally, type a short description of your disk image (maximum
1,024 characters) into the Image description  text box.

T Click Next , which will take you to Create Another window. Active@ Disk
Image also supports creating of multiple image files simultaneously:

I To create an additional image file check Yes, create another
image . This will open another wizard where you will need to choose
the settings (select Backup type, choose drive and partitions, etc )
for this image file from the beginning.
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1 Inorder to create Raw image check Yes, create another Raw
image. New wizard will start asking you pick the drive you want
backup in Raw Image format. Later you will need to choose Backup
location, set Image options, etc. Basically you will need to repeat
previously explained steps (5-8)

9 If you do not want to create any additional images you just click
Next , since No, Proceed to confirmation is selected by default.

After clicking on Next th e Confirm Operation Details page will show up.

Disk to Image Wizard
Confirm Operation Details < -
verify the list of actions about to be performed. To proceed with actions, dick Next, w !P
Creating Backup
MName: DiskImage
Backup type: Full backup
Location: D:\DiskImage,
Compression: Mormal
Protection: Mot protected
File splitting: Automatic (try single file)
Description:
Operation 1of 1
Disk: 0, INTEL S5DSC2CW240A3, 5/N:CVCV21210072240CGN, 223.6 GB
Partition: Local Disk {C:)
File system: MTFS
Capadty: 223.6GB
Verify after creating [] shutdown when finished [ Minimize in tray

< Back Cancel

Do the following:
1 Review the details in the summary.
1 Verify after creating is checked as default.

9 Shut down when finished - choose this option if you plan to create
an image during the night or while you are away

1 Minimize in tray - checking this will minimize Active@ Disk Image in
system tray, freeing your Taskbar and Desktop

By clicking on Next you will initialize the image file creation and open the
Progress Status page.

29



Disk to Image Wizard

Progress Status
Current status of the operation

Backup file: D:'\DiskImage \DiskImage. adi Minimize in tray
Time started: 20:59:56 Compression: Normal

Time elapsed: 00:00: 10 Security: Mot protected

Time remaining: 00:10:56 Speed: 391 MB/fs

Operation 1 of 1
Creating image of partiton (NTFS, 202.9 GB/223.6 GB, Disk 0, C:)

Total progress 3.0 GB of 202.9 GB

MNext = Cancel

1 To stop the operation at any tim e, click Cancel .

S

-:ANote The compression ratio and the compression speed depend on multiple
factors. For example, .doc files under the Normal Compression can be
reduced to up to 80% and up to 90% with High Compression. On the
other hand image (f.e. jpegs) f iles are not compressible, while .exe files
can be reduced by 40%-50% in Normal Compression and 50%-60% in
High Compression.

Compression speed can vary a lot depending on how fast your CPU is,
how fast is the drive whose image you are making and how fast is the
disk where you will be storing that particular image. We recommend that
you stick with Normal compression since it has the best performance
ratio. It is not as slow as the High Compression (it & around x1.5-x2
faster) and it has a slightly lesser compression result (around 10% less).

—
-j Note For more detailed instructions and support, see the Active@ Disk Image
User Guide
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3.1.2 Active@ Data CD/DVD Burner
To use Active@ Data CD/DVD Burner:
1. From the Active@ Boot Disk shell, clickStart > Programs >

CD/DVD Burner . This will open Active@ Data CD/DVD Burner

4 Active® Data CD/DVD/Blu-ray Burner -0
# o ”
% a l-—JJ o le- WL @
Target Options
Disk Label
DTSOFT BDROM (L:) Empty ~ | Transport SPTI
Thu February 26 2015
@ ltems to burn Size Date Modified File System
| = Root of the File Tree (Thu Feh... 26-Feb-15 7:51:55 PM UDF (Universal Disc Format) -
1 Load collection Ctrl+L Speed
(l  Save collection Ctrl+5 Auto-Select -
o Addfile Burning Action
li;  Add folder P | L. Add existing folder Ins
Rename folder F6 | Create new folder
Delete Del T Action after Burning
[ verify Data
Eject Media
[] Quit Burner
[[] shutdown PC
.. Event View
@ 26-Feb-15 7:51:55 PM: Scanning devices ') Bumpata
@ 26-Feb-15 7:51:55 PM: Scanning complete. (SPTI Transport)
] P P

Total Folders: 0 Files: 0 Size: 0 bytes (0 bytes)

Copyright (C) LSoft Tachnologies Inc. 1999-2014

Place a writable CD/DVD in the drive.
To add a file or a folder just right drag & drop the fil e into the Base field. Or

you can right click on the base field and choose the Add file or Add folder

data type and continue browsing from there .

Active@ Data
dialog box.

1  When you find the file or folder you are looking for, select it and click Open.

The name of the selected file or folder will appear in the Base area. When
browsing you can select multiple files from the same folder and add them to

the Root list.

I Toremove an item from the Root list, right click on it and choose Delete .
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Active@ Data CD/DVD/Blu-ray Burner = =

RAF k- VT O-

Target Options
Disk Label
TSSTcorp CODVDW SH-5223C (E:) Empty ¥ Transport |SFTI =
Thu February 25 2015
@ Items to burn Size Date Modified File System
4 |iZ| Root of the File Tree (Thu Feb..,  28-Feb-1510:43:18 PM UDF {Universal Disc Format) -
[DataBurnerexe L
@ Load collection Ctrl+L Speed
Il Save collection Ctrl+S AutoSelect -
o+ Addfile Burning Action
). Add folder » Erase Media
Rename folder F& Burn in Test mode
. Delet Del
x slete < Action after Burning

[] verify Data
Eject Media
[ Quit Burner
[] shutdown PC

. Event View

© 28-Feb-1510:43:18 PM: Scanning devices “ 9 bumbata
© 23-Feb-1510:43:18 PM: Scanning complete. (SPTI Transport)

Total Folders: 0 Files: 1 Size: 700.305 KB (717,112 bytes) ‘Copyright (C) LSoft Technologies Inc. 1999-2014

1 To label the CD/DVD, type a descriptive label in Disc Label .
1 Select a drive and a write speed from the Burner drop-down list.
1 ClickBURNDATA

Files are written to the CD/DVD.
—

-ﬂ Note For more detailed instructions and support, see the Active@ CD/DVD
Burner User Guide
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3.1.3 Active@ Partition Recovery

Active@ Partition Recoveryis a data recovery utility that you can use to:
1 Find and recover deleted partitions and logical drives

1 Last Chance- if all recovery methods fail, you can still try to save individual
files on your deleted partition.

i Create a Drive Image for backup purposes
1 Fix or create a typical MBR (Master BootRecord)

This means that you can recover deleted or damaged partitions located on data volumes
(D, E:, and so on), attached hard drives, as well as on the external USB drives and
Memory Cards (SunDisk, MemoryStick, CompactFlash, etc.). On a systenpartition,
BOOT.INI is corrected automatically (if needed) to repair an un -bootable system. As
well, damaged Volume Boot Sectors are corrected to maintain integrity of the partition.
This utility also enables you to fix a damaged MBR and to delete invalid partitions.

For any computer to boot properly, the following conditions must apply:
1 The MBR (Master Boot Record) exists andit is not damaged in any way
1 The Partition Table exists and contains at least one active partition

If these conditions exist, the executable code in the MBR selects an active partition and
passes control to it so that it can start loading the system files (COMMAND.COM, NTLDR,
BOOTMGR,.).

If these files are missing or are corrupted then the operating system will not boot.

Data Re covery Tips

DO NOT WRITE ANYTHING ON THE DRIVE THAT CONTAINS YOUR IMPORTANT
DELETED DATA!

When you install software, you write data on the disk. This can destroy your deleted
data. If you have only one logical drive, physically remove the hard drive from the
computer and install it as a second logical drive on another computer where data
recovery may be possible.

DO NOT SAVE RECOVERED DATA ON THE SAME DRIVE THAT CONTAINS THE LOST OR
DAMAGED DATA!

When saving recovered data, you are writing records to the file table. If you write these
records to the same drive that contains the damaged data, you are destroying the file
table records that you are trying to recover. At the same time, you may be destroying
the file table records for other deleted entries. It is best to save recovered data onto
another logical, removable or network drive.

CREATE A RAW DISK IMAGE IF YOU HAVE AN EXTRA HARD DRIVE, OR OTHER
LOGICAL DRIVES THAT ARE BIG ENOUGH!

A Raw Disk Image is a single file that stores all the data from your logical drive or
physical device as a mirror image. Having a Raw Disk Image can be useful when you
want to back up the contents of the whole drive, and restore it or work with it later.
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Before you start recovering deleted files, it may be a good idea to create a Raw Disk
Image for the one drive, if you have enough space on another drive. If you do
something wrong while recovering the files (for example, recovering them onto the
same drive and destroying the data), you will be able to recover these deleted files and
folders from the Raw Disk Image that you have wisely created in advance.

Find and recover deleted partitions and logical drives
To find and recover deleted partitions and logical drives:

1. From the Active@ Boot Disk shell, clickStart > Programs > Active@ Partition
Recovery. The Active@ Partition Recovery workspace appears with all available
devices listed in a tree view under Local System Devices.

L ] Active@ Partition Recovery for Windows Professional [Licensed to: LSoft Technologies] = E
File \View Tools Help

@ QuickScan Q SuperScan Kigy Recover &’.}‘] LastChance Q .;;-

[ ocal System Devices 2| Partitions [3]

= Name F/s Size Serial Start Sector | Sectors LastSector  MRUFAT | M
P Fived Disk |9 Local Disk (C:) NTFS 24GE 12846634 2048 46836631 468838878 Tas432

<7 Fixed Disk1 SAMSUN.-.. |5} ynyiigcated space Unallocated 100 B 1 2047 2047

[ Removable Disk2 Kings... | & Unallocsted Space Unallocated 159 MB 468858820 348 46Bse212T

*  Date/Time Event
© 2015-02-26 21:38:29  Active® Partition Recovery v. 12.0.1 started, 64-bit executable
© 2015-02-26 21:38:32  Kemel 5.02.10 intialzed

3 object(s) Contents of Fixed Disk) INTEL SSDSC2CW240A3

I To scan an unallocated space, select it. Known details of the selected item
are displayed in the right pane.

1 To scan the unallocated spacein basic mode, click Quick Scan , the process
will start and the status bar will display the scan progress After the scan is
complete, a list of all allocated and unallocated partitions will appear in the
Local System Devices list.

1 If you cannot see a logical drive, you will need to process the whole surface
of a disk, select it and right click on it and click Super Scan .

34 Active@ Boot Disk User Guide



k) SuperScan Options

ﬁ-; INTEL SSDSC2CW240A3

Scan Areas

From Size

L — s [ o] [ ada || neno
Bytes

Analyze and detect deleted or ME i

Windows & Mac0S: 1{ce 1 FAT/jexFaT [0 HFs+

Linux & Uni: ] Ext2fExt3/Ext4 [ BtFs O urs

T When the Super Scan Options dialog box appears, do the following:

To restrict the scan to a small number of sectors, indicate the From sector

and the number of sectors to scan. If you are unsure about any of this, just
ignore this step and click on Scan.

You can follow the scanning progress via status bar

P Active® Partition Recovery for Windows Professional [Licensed to: LSoft Technologies] - o
File View Tools Help

@ o Q) QuickScan Q SuperScan Lfa? Recover FL‘;] LastChance ),
B Local System Devices

4 & Fixed Disk0 INTEL SS...

Unallocated Space

» [# Local Di

&) Unalloc: ace

» & Fixed Disk1 SAMSUN...

» Removable Disk2 Kings...

»

[i5] Partbons [16] | =3 superscan [24%] |

Partitions Legend

Sectors Time

Detected
Total: 468,862,128 | Total:  00:07:54| | yoiumes; %
O ome © MR @ MAMm B Bad Sectors To Scan: 463,856,332 Elapsed:  00:01:23
Scanned: 114,491,392 Left: o0:06:31 || FleRecords: 150,144

\
*  Date/Time Event

© 2015-02-26 23:14:45  Volume detected [NO NAME] (FAT, 1.41 MB, Integrity Status: Excellent, Start sector: 27,601,528 Sectors: 2.
@ 2015-02-26 23:14:58  Volume detected [NO NAME] (FAT, 1.41 MB, Integrity Status: Excellent, Start sector: 39,218,464 Sectors: .
© 2015-02-26 23:14:50  Volume detected [NO NAME] (FAT, 141 MB, Integrity Status: Excellent, Start sector: 40,292,520 Sectors: .
© 2015-02-6 23:15:01  Volume detected [NO NAME] (FAT, 2.81 MB, Integrity Status: Excellent, Start sector: 41,751,000 Sectors:
@ 2015-02-26 23:15112  Volume detected [NO NAME] (FAT, 1.41 MB, Integrity Status: Excellent, Start sector: 52,121,944 Sectors:

Contents of SuperScan [2015-02-26 753:14:11]

3 object(s)

After the scan is complete, a new folder named SuperScan will be created
in the Local System Devices list.

I To display a smaller set of SuperScan results, do the following:
a. Right-click the SuperScan device node folder.

b. From the context menu choose Filter... This will open the Filter
Found Partitions  dialog box.
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1

= Filter Found Volumes
File System
Windows & Mac05: 1 NTFS ] FAT/exFAT
Linux & Unic ] Ext2/Ext3/Extq #1 BtFS
Volume Size
[ Limit: 0| MB to: 0| MB

[ Basic Filtering B Advanced Filtering

Basic Filtering [Volume Status]

#] HFS+

#1 UFs

#1 Excellent #] VeryGood ] Good #] Acceptable  § MotBad
#1 Poor ¥ Bad #1 Very Bad #1 Invalid
B = peci TFS a = pes FAT & Ites

ﬁ Primary Boot Sector

ﬁ Copy of Boot Sector

ﬁ Primary Boot Sector matches a Copy

& Most likely quick-formatted

Filter Cancel

c. Scanning for all supported file types is on by default. If there are
particular file types that you do not want to be displayed clear the

check boxes besides them.

d. To display only those patrtitions within a specified size limit, in the
Partition Size area, indicate the minimum and maximum size of

partitions in Megabytes.

e. To use basic filtering parameters, in the Filter Type area, click Use

Basic Filtering

f. To select displayed partitions based on partition status, in the Basic

Filtering [Partition Stat

us] area, clear the check box next to each

partition status number that you do not want to display.
g. To use advanced filtering parameters, in the Filter Type area, click Use

Advanced Filtering

h. To restrict displayed results for NTFS specific parameters, in the

Advanced Filtering [NTFS specific]

area, select the check box

beside all the types of data that you want to display

i. To restrict displayed results for FAT-specific parameters, in the

Advanced Filtering [FAT specific]

area, select the check box

beside al the types of data that you want to display.

j. Click Filter . The right panel will display the filtered results.

In order to recover your partition you will need to click on the SuperScan
folder in Local System Devices this will show the SuperScan results in the

right pane.

I f you didndt do

anything wi

th the

partition, chancesare pretty good of recovering it.

Active@ Boot Disk User Guide
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5 Recavery Options

E%} Local Disk (1:) Located on SAMSUNG HD103S] 93.3 GB

|2 Recover Volume In-Place | | &} Copy All Data to a New Disk

Assign Disk Letter F: s
[ setPartition Active (boot Operating System from it)

[ Create Extended Partition First
& use ALL Unallocated area

Boot Sector Check & Fix
B Automatic B Manual

Recover Cancel

To ensure that the Windows operating system assigns the correct letter
to the disk, select a disk letter f rom the Assign Disk Letter  drop-down
list.

To set the recovered partition as active and allow the system to boot
from it, select the Set Partition Active  check box.

The recovery process checks the boot sector and fixes it if it is damaged.
Select Automatic or Manual , depending on how you want to do this.

If the disk has an extended partition, select the Create Extended
Partition First check box and/or use ALL Unallocated area  check
box. If these areas are not available, these check boxes will be disabled.

To save a copy of the partitioning information before recovering, select
the Backup Current Partitioning Info check box and indicate the file
name to store the backup.

Click Recover .

The patrtition is recovered.

T Youcan manage other aspects of SuperScan results:

a.

To save scan results, right-click on the SuperScan folder and choose
Save Scan Results . You can also open the saved scan results at any
time.

To delete a SuperScan folder, right-click on the folder and choose Delete.
To display detailed properties of a SuperScan folder, right-click on the
folder and choose Properties.

I LastChance -if youwereunluckyand vy ou sanagdelto retover podrt
partition there is still a chance to recover at least part of it. This is where
LastChance comes into play. By simply scanning the area of the deleted
partition you can find and recover lost files, that were presumed to be lost. In
order to run LastChance do the following:
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k. Click on the LastChance button in the top menu, this will open the
LastChance wizard box

|. Choose the device where your previously deleted partition was being
stored

D LastChance Recovery - Recover all files recognizable by their signatures
This recovery method is helpful when primary recovery methods (QuickScan and SuperScan) haven't
detected your partitions being deleted or damaged.

Select the drives you wish to analyze from the choices below, and the types of files you want to look for, and well try to
detect all un-fragmented files based on their standard signatures. In most cases we will be able to detect and properly
recover the contents of lost files, However we won't be able to detect the file system attributes {eg. original filename,
creation date, modification date etc). Detected and recovered files will be grouped by file extension only, and will have
ahstract file names. The File Organizing feature will help you to group your files into folders based an extended file
attributes. For example, songs may be grouped by artist and or album, and photo images may be grouped by camera and
the date the photo was taken.

Local System Device

u Fixed Disk0 INTEL SSDSC2CW240A3 (224 GB)
O

u Fixed Disk1 SAMSUNG HD1035] (332 GB)

#

l"‘.T Remavable Disk2 Kingston DataTraveler 2.0 USB Device (7.32 GE)
O

The purpose of LastChance Recovery is toenable you to scan and recover files
based on their signatures or by their default application. All of the supported fil es
are checked by default, if you donot
them since this will greatly speed-up the process.

k) LastChance Recovery - Recover all files recognizable by their signatures

Confirm file types to be analyzed and recovered

We recommend that you de-select file types you are not interested in recovering. This will speed up the process
significantly.

-

Types of files to look for

b ¥ AdobeFiles
b #] Camera Raw Files

F ¥ Compressed Archives
b #] Electronic Books

b ¥ FileMaker Platform

b #] Formatted Text Files

b #1 Microsoft Office

b #] Miscellaneous

b ¥ Music & Audio Files

b #] Photos & Images

F #] CQuickTime Multimedia
b ¥ Video Files

Back Start

Once you click on the Start the scanning will commence and can take to around
a few hours. Depending on your drive size and the number of file types you
inputted, your mileage might vary. Once the scanning starts you can pause it but
you cand stop it.

Active@ Boot Disk User Guide
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Creating a Raw Disk Image

A Raw Disk Image is a mirror copy of your entire logical drive or physical device stored
as set of files. It may be a good idea to create a Raw Disk Image for a drive containing
deleted files that you want to recover, if you have enough space on another drive. If you
do something wrong while attempting to recover a partition, you will be able to recover
these deleted files and folders from the Raw Disk Image of that partition.

Depending on the disk image creation settings, a Raw Disk Image consists of a
configuration file (with an extension .DIM) and a single file chunk, or set of files having
extensions .000, .001, .002 ... (each file chunk has a size of 2@ in this case).

u Important Do not save a Raw Disk Image back onto the disk that you are
backing up. The target location to save the Raw Disk Image must always be another
drive.

To create a Raw Disk Image:

1. Inthe Active@ Partition Recovery workspace, slect a logical drive or a physical
device. Right click on it and choose Create Dik Image. Which will launch the
dialog box.

1 Inthe Save In drop-down list, select another physical device or another
logical drive.

1 Browse to the folder where you want to save the Disk Image.
1 In File Name , give the Disk Image file a descriptive name.
1 Clik Save, the process will start and the progress bar will appear .

1

Watch the progress and wait while drive's contents are copied to the new location. You
can cancel the process of image creation anytime by clicking Stop.

Fixing or creating the MBR

The MBR(Master Boot Record) is created when you generate the first partition on a
hard disk. It is probably the most important data structure on the disk. The MBR
contains the partition table for the disk and a small amount of executable code. On x86 -
based computers, the executable code examines the Partition Table, and identifies the
system partition. The MBR then finds the system partition's starting locat ion on the disk,
and loads the copy of its Partition Boot Sector into the RAM The MBR then transfers
execution to executable code in the Partition Boot Sector.

To fix or create a typical MBR:

1. Inthe Active@ Partition Recovery workspace, in the Local Syst em Devices list,
select a disk.

I From the Tools menu, choose Fix Boot Sector
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9 Partition Boot Sector Recovery Options window is the next step in fixing your
Boot Sector. Primary Boot Sector column (PBS) on the left must have same
values as the Copy of Boot Sector (CBS) on the right

] Partition Boot Sector Recovery Options

Partition Primary Boot Sector (PBS) MUST match Copy of Boot Sector (CBS) and both boot sectors must be valid for the recovered
drive to be accessible by operating system. Please choose a proper action based on PBS and CBS parameters and the Overall Status.

Primary Boot Sector Copy of Boot Sector Boot Sector Template
File System Identificator: || NTFS =) NTFS [ ] MNTFS
Hidden Sectors: ° e
SMFT Start Cluster: ° e
SMFTMir Start Cluster: ° e
MFT Record Size (bytes): 0 e
Index Block Size (bytes): e e
Sectors per Cluster: ° e 3]
Total Sectors: e e
aytes per Secor: ° °
Signature (55 AA): || 5584 o S5AA ) 55AA
Overall Status Action

ﬁ PES looks valid

ﬁ CBS looks wvalid

@ PBS matches CBS
ﬁ Ready for Recovery

The MBR is fixed.
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B Duplicate the Primary Boot Sector (PBS) into a Copy of the Boot Sector {CBS)
B Duplicate a Copy of the Boot Sector (CBS) into a Primary Boot Sector (PBS)
B Copy the Boot Sector Template into both Boot Sectors. PES CBS look invalid

B Do NOT fix Boot Sectors. Both sectors lock valid and PBS matches CBS

Recovery User Guide.

[ Recover ] [ Cancel

A Note For more detailed instructions and support, see the Active@ Partition

Active@ Boot Disk User Guide



3.1.4 Active@ File Recovery

Active@ File Recoveryis a data recovery utility that you can use to restore accidentally
deleted files and folders located on the existing drives, and even on deleted or damaged
partitions.

It is best to save recovered data on anot her physical, logical, removable or network
drive. Make sure that you have access to another physical or logical drive before
attempting to recover a file.

To run Active@ File Recovery:

1. From the Active@ Boot Disk shell, click Start > Programs > Active@ F ile
Recovery . The Active@ File Recovery workspace will show up with all
available devices listed in a tree view under Local System Devices

1 To scan a logical drive, select it. A message in the right pane reads Disk not
scanned yet...

1 To scan the drive in basic mode, do the following:

a. Click Quick Scan . The status bar will be displaying the progress of the
scan.

b. After the scan is complete, files and folders will be listed in the right pane.

) Active® File Recovery for Windows Professional [Licensed to: LSoft Technologies) - B

File View Tools Help

5] e -
O Back ickScan P SuperSe Ek Search E},R "]L t Ch = D
o (Qoscmne  [G soeson PO . Byoome 45 D 3

B8] ocal System Devices & Local Disk (C:) @ Search
4 &P Fixed Disk0 INTEL SSDSC2CW240A3 Name B Size Created Modified Accessed/Deleted _ Attributes | ID pix
v [ 7 !Lost & Found! 18668 D

—— 3 setend 346GB 2014-03-0201:4525  2014-03-0201:45:28  2014-03-0201:45:26 SH 1

4 &P Fixed Disk1 SAMSUNG HD1035) ] SRECYCLEBIN 323MB 2014-09-2623:30:24  2015-02-11 20:36:16  2015-02-11 20:36:16 SH &1

[ Local Disk D) 23 AmD 4B0ME 2015-02-15020308  2015-02-15 020308 2015-02-15 020308 se06e

» =) Removable Disk2 Kingston DataTraveler 2.0 USB Device || AMD 256MB 20141228 124611 2015-02-14 12:15:25  2015-02-1412:1525 ) 240010

3 barcode Obytes 2014-12-19 222001 2014-12-1922:29:01  2014-12-1922:2901 26768

g 17.8MB 2014-03-0201:43:40  2015-02-1205:22:38  2015-02-1205:2238 sH 75101

Obytes 2015-02-25 203558 2015-02-25 20:35:58  2015-02-25 20:35:56 92082

Obytes 2013-08-22 16:45:52  2013-08-22 16:45:52  2013-08-22 16:45:52 sH 17502

196 bytes 2012-07-130437:28  2014-07-13 04:3734  2014-07-13 043734 151091

Obytes 2014-12-192228:01  2014-12-1922:28:01  2014-12-19 22:29:01 s
842MB 2014-03-0406:58:42  2015-02-1421:11:42  2015-02-1421:11:42 100122

Obytes 2014-03-1717:53:31  2014-05-02 2:05:43  2014-05-02 23:05:43 55618

Obytes 2014-00-1810:2820  2014-09-27 01:36:29  2014-09-27 01:36:29 116810
9.03MB 2014-03-01 16:46:55  2014-10-1417:50:20  2014-10-14 17:50:20 55704
Obytes 2014-12-192220.01  2014-12-1922:29:01  2014-12-19 22:29:01 27086
Obytes 2014-11-06 171326 201d-11-06 17:13:26  2014-11-0617:13:26 235785
615MB 2014-03-02 10:07:55  2014-03-02 10:07:55  2014-03-02 10:07:55 HR 2112
Obytes 2013-08-22 17:36:30  2013-08-22 17:22:35  2013-08-2217:22:35 62
4.83GB 2013-03-22 15:36:15  2015-02-26 12:20:03  2015-02-26.12:20:03 R 63
141GB 2013-03-22 15:36:15  2015-02-2612:18:32  2015-02-26,12:19:32 1800
2.45GB 2013-08-22 153615 2015-02-1714:3231  2015-02-17 14:32:31 H 1856
213MB 2014-03-01 16:42:13  2014-03-01 16:42:13  2014-03-01 16:42:13 SH 32231
9.4 GB 2014-03-0201:41:55  2015-02-27 10:09:00  2015-02-27 10:09:00 SH 75243
27.1KB 2014-07-22 123513 2014-10-14 15:36:19  2014-10-14 1536119 19914
34168 2013-08-22 153615 2014-03-01 16:48:41  2014-03-01 16:48:41 R 1972
176GB 2013-08-22 15:36:15  2015-02-28 11:53:34  2015-02-2811:53:34 w24 |-
£/ 14 01 AAALAEIAE AN AT AIBIAEAZ  ABLL BT 0701 AL , .

* | Dateffime Event

@ 2015-03-01 03:27:21 Kemel 5.02.10 initialized

42 object(s) Contents of Local Disk (C:)

1 Recovering via SuperScan if you cannot locate or find your deleted files and
folders, to process the whole surface of a disk, right click on it and click
SuperScan .

T When the SuperScan Options dialog box shows up, do the following:
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i SuperScan Options

e

"‘"--9 INTEL S5DSC2CW240A3

& General | !%gl Signatures Recognition
Scan Areas

From
0 bytes (0 sector)

From D] [Sechnrs S

Analyze and detect deleted or damaged partitions
Windows & Mac0S: #1 NTFS

[ Ext2/Ext3/Exts

Linux & Unic

Files to be recognized based on their signatures

B None (Fast)

Size

B all signatures (Slow)

224 GB (468862128 sectors)

| amssaizs| | add || Remove

] FAT/exFAT # HFs+
[ BtFs [ urs

B Documents & Photos only

In General tab , you can restrict the scan to a small number of sectors,

indicate the From sector

and the number of sectors to scan. Limiting the

scan on a small area can greatly reduce the time required for scan to finish.
Again if you are not sure about this option just leave it as is.

You can further limit the search by focusing it on the file systems that exist
on your deleted or damaged partitions

o SuperScan Options

p—
"""--9 INTEL SSDSC2CW240A3

& General Eé Signatures Recognition

Types of files to look for

» [ Video Files
[ QuickTime Multimedia
#1 Photos & Images
[J Music & Audio Files
[ Miscellaneous
1 Microsoft Office

[ FileMaker Platform
[] Electronic Books

[] Compressed Archives
[J Camera Raw Files

3
4
»
»
»
b [ Formatted Text Files
4
»
»
3
3

[J Adobe Files

In Signatures Recognition

Load Custom Signatures

[ Scan ] [ Cancel ]

tab you can further specify which file types

would you want Active@ File Recovery to search for Thanks to in-built tools
File Recovery can rebuild file types (DOC, JPG, DOC, ZIP, etcYrom patrtial
data that y ou really need, ignoring the irrelevant data and saving processing

time.

Click Scan. The status bar displays the progress of the scan.

Active@ Boot Disk User Guide
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& 1% complete Active@® File Recovery - 0
File View Tools Help

: - — S == .
& s @Qu\tksmn Q SuperScan Ei_ search Ed?r(zmver L.:-Itast(han(e =B w 3

B L ocal System Devices
4 &P Fived Disk0 INTEL SSDSC2CW240A3
|3 Local Disk (C2)
» & Fixed Disk1 SAMSUNG HD103SJ
» Removable Disk2 Kingston DataTraveler 2.0 USB Device
> % SuperScan [2015-03-01 15:56:56]
»

Volumes [0] arch | = Superscan [1%] Signature Files [12521]

Partitions Legend Sectors Time Detected
Total: 468,862,128 | Total: 01:21:21
U Ezizmre To Scan: 468,862,128 | Elapsed:  00:01:13 || Sianatwe Fles: 12,521
Scanned: 5,720,064 | Left: 01:20:08
(] %
= DatefTime Event
© 2015-03-0115:48:14 Kernel 5.02.10 initialized
© 2015-03-011556:56 Device SuperScan started on Kingston DataTraveler 2.0 USB Device
4 2015-03-0115:57:07 Device SuperScan stopped
2015-03-0115:57:20 Device SuperScan started on INTEL SSDSC2CW240A3
0 object(s) Contents of SuperScan [2015-03-01 15:57:20]

After the scan is complete, a list of detected partitions appears in the right
pane. You may search through these patrtitions.

If you chose to re -build image files, a folder named Files Recognized by
Signatures will be created. After the recovery you can search through the
contents of this folder.

After you have scanned a drive, all you need to do now is to search for
deleted or damaged folders or files:

a. To search manually, click on the SuperScan result. This will show the
scanned files in the right pane

& Active@ File Recovery for Windows Professional [Licensed to: LSoft Technologies] - olEHE
File View Tools Help

- . ~ -
Back i Supers {g, s E’i?‘R Last
Py @Q Q e , s P G 3B QO 3

[ Local System Devices [5] volumes [0] | [gSearch | E@superscan [100%] | o Signature Fies [32955] |
4 &P Fixed Disk0 INTEL SSDSC2CW240A3 Show Atributes: E] Subsequent Column Sorting:
(8 LocalDisk (€) Name M Size Count Attr#1 Attr#2 Attr#3 Attr #4
» <P Fixed Disk1 SAMSUNG HD1035) 4 (3 Photos & Images 6.54GB 80243
» =] Removable Disk2 Kingston DataTraveler 2.0 USB Device = 1eaGh 3364
- 9 » ) ico 87.0MB 3615
» % SuperScan [2015-03-01 15:56:56] » €1 png 560 MB 34079
» (0 gif 13.1 MB 7935
4 57
. SuperScan [2015-03-01 15:57:20] b @ bmp 5B ot0
L4 Signature Fles » €3 mng 513 KB 2
» 3 ani 3.18MB 8
b 0D tif 3.83GB 0
4[] Microsoft Office 436GB 272
» 3 ole 423GB 2450
» 3 doc 18.9MB 24
» 1 doox 69.9 MB "7
» 53 s 118 MB 13
» B 492 KB 9
b G pptx 39.7MB 10
» 3 ppt 41.0KB 4
» £ mdb 120 MB 1
> 03 odt 236MB 84
a >
= DatefTime Event
© 2015-03-01 15:48:14 Kernel 5.02.10 initialized
-03-0115:56:56 Device SuperScan started on Kingston DataTraveler 2.0 USB Device
-03-0115:57:07 Device SuperSean stopped
@ 2015-03-0115:57:20 Device SuperScan started on INTEL SSDSC2CW240A3
© 2015-03-01 16:47:02 Device SuperScan completed
0 abject(s) Cantents of SuperScan [2015-03-01 15:57:20]
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9 Click on the file type you are interested in and you can organize them by size
and various other attributes such as camera model, date created, width,
height, etc.

a. You can also preview the scanned files by right clicking on one of them
and choosing the Preview option

% Actived File Recovery for Windows Professional [Licensed to: LSoft Technologies] - o IEd
File Wew Took Help

o Qo Qe Qo G By L ® 3

’immiynm.wcu [2 whmes [0 | e | of sperson ows] | Sratan es (755 |

+ &P Fived Diskd INTEL SSDSC20W240A3 | S orgarirer sonameoe 5§ sbaentcamsams: (o 3
+ 18 Loeal Dk )
+ & Ficed Disk1 SAMSUNG HD1035)

hiame s T | Count amel A2 e Ateea Anrs =]
v 0w 383GB 40 SOFTWARE CREATED WIDTH HEIGHT DESCRIFTION
« [ ina 16468 33645 MODEL CREATED DESCRIETION  AP¥Z COMMENTS
o570 81 WD

Freview of Found 132662184 4112564)pg

1B
s45M8 1ECPROFILE
228 1ECPROFILE
186ME IECPROFILE
163 MB ICCPROFILE
7420

e

467TMB

443 1B

Lome Canon Pawasth. . 20141031

A0 M8

La0me

43818

4388

43608

I’ inme Canon Powessh... 2012-10-51

Mn1SLpy 42118

[a19610pg JRer Canon Rowessh... 2012-10-31

418MB

Li6MB
a1me

402MB| [ Faisting anly
303

051
39 100 PROFILE
Ty im e o
-0
e e
Kol 3.03:10ieiiaized Inzpect Reu Fle Data
ne

' o Inspect File Heades.,
0 20150301 155720 rted on [NTEL 55D
@ 20150301 s peted [Ererees) St
0 20750300 163533 L Freperies ateEnter Bl 15

© sbjectis) Contarts of SuperScan (20 15,03 01 18:57:30]

b. Active@ File Recovery also supports Windows shortcuts. Meaning that you
can select and recover multiple individual files by clicking on them and
holding Shift or Ctrl .

1 Once you have found and selected the files you want to recover right click on
the and choose Recover

5 Active@ File Recovery for Windows Professional [Licensed to: LSaft Technologies] - o IEE

File View Tools Help

€ Ross  Powsw Qoo [Gree Egeon . 9 o

Lccal System Devices. Zokmes 0] | gSearch | £ sumersan [10%] o Sonahure Fhes (32955
4 & Fixed DiskD INTEL SSDSC2CW24043 3 Onganies Show Atiess 5§ | Sbsenert ok Sartig: (o0 % |
» @ Locuibiskicy Mame st T |Cout = Az s s w3 ]
+ @ Fised Disk1 SAMSUNG HD1035) BT 183GB 40 SOFTWARE CREATED WIDTH HEIGHT DESCRIPTION
+ %] Remowable Disk2 Kingston DataTraveler 2.0 USB Device <9 'WF ) . '1‘;:3: 33645 MODEL CREATED DESCRIPTION  APF2 COMMENTS
+ B superscan [2015-02-01 1556561 128008
« b4 superscan [2015-03-01 1557200 =L Lt
i Signaturs Files

RAELE)

ERELEE)

s

reres

asme Cemon PoweSh, 20140510

e 1€ PROFILE

e Cencn PowerSha 2014-0618

= 0]
Kingston DataTraveler 2.0 US2 Device:
INTEL SSDSCCHAAS
T:02
D 301500 185835 -
L Contents of Superscan (01503491 15:57:20)

1 Recovery Options window will pop up asking you to choose or confirm the
Recovery location for your files.
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1 You can also limit the recovery on only those files that have been
deleted.

1 If you are recovering files that have been damaged make sure to
check Existing only  check box

9 Of course, if you are trying to recover some of the files that have
been deleted as well as some of them that have been damaged make
sure to mark All check box

1 Do not recover your deleted files on the same hard drive wh ere you have
previously deleted them

) Recovery Options
Target name and output folder where to recover to:
Name: Multiple selection: 16 file(s), Size: 130 MB

Recover to: | D:)

B al B Deleted only B Existing only
[0 Recover named streams #1 Organize by file meta-data
#1 Browse output folder after recavery Attribute-based folder depth . =

more options... Recover Cancel

1 For further customization clickonmo r e o p t in thebotéom left corner,
this will open the Settings window.

% Settings & Settings &) Settings
% ceneral | W Recovery | o Images B General | 8 Recovery i tmages % General | YW Recovery | g Images
Scan results storage path Default recovery path Default image storage path
C:\Program Files\LSoft Technologies\Active @ File Recovery! - D:\ [ ] D:\
Optians Options Actions
[ Use Quickscan Plus by default #] show popup hints H Al B Deleted only B Existing only #] Lock before imaging
[ Auto-save SuperScan resuits R # Tgnore lock error
[ Ignore writing errors B Use original fle names (recommended) #1 Ignore read ermors
] Tanore reading errors B Rename fies to: [ Ignore write erors
#] Query file metaata properties for Signature Files S— (00001) Compression [RAW Image (ot compressed) % |
1 skip = of sectors if bad sector detected 10 =
Existing file conflict resolution S
Local Devices Suppart | Generate unique file name {recommended) B Try one chunk
#] Initilize Hard Disks [ Initialize CD/DVD/BD Disks 0 A B Use custom chunk size
##] Initialize Removable Disks [ Initizlize Floppy Disks B Gverwrite without prompt size {10 GB)
B Skip exdsting fles =
Event logging Minimal % Application Style Light ¥
Apply Cancel Apply Cancel Apply Cancel

1 Inthe General window you can choose the storage location for your

Scan results as well as some other options concerning scanning and your
local devices

1 Recovery tab basically has the features from the initial Recovery
Options window. Additionally you can automatically rename your
recovered files be giving them a basic name and adding a number for
eachone | ater on. The ae@mddaul t name i s

1 Images tab is reserved for image creation and storing. Here you can
designate image storage path, compression, chunk size, etc.
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When you are finished with changes in this window click Apply before exiting

and you will be back to the initial Recovery Options Window

In the Recovery Options

window click on Recovery button which will

initiate the recover the deleted files at the location that requested.

Alternatively you can also use Advanced Search

drive that contains your deleted files, or just by selecting it and choosing
Search in the top menu

New Search window will appear offering you various customization settings

o

Find what:

File type:

Search

Search in:
INTEL SSDSC2CW240A3

[=Dock;=Mp3=1pG |

Search pattern or patterns (wildcards and regular expressions supported)

[all Files and Folders] S

B

ooooo O

All Files and Folders B MNon-deleted B Deleted

Case sensitive search

Created From:
Modified
Accessed/Deleted

Size (KB)

1D

Find Cancel

a.In the Find What field, enter all or part of a file or folder name. You
can use wildcard characters to locate all files or folders that include
that part in a name.

b. In the File Type drop-down list, select the type of file or folder to
search for.

c. In the next three check b oxes, you can choose to include:

1 Deleted files and folders

- Select this check box to search

through files and folders marked as deleted. If you know that the
file or folder you are searching for has not been deleted, that is - if
the file or folder is dam aged and still exists in the file table - clear

this check box.
I Non-deleted files and folders

tool by right cli cking on the

- Select this check box to search

through existing files and folders. If you know that you are
searching for a deleted file or folder, clear this check box.

1 Allfiles and folders

- combines two previous search methods,

enabling you to look for files and folders in different states.

d. Case insensitive search

- File Recovery will search for the Find

What file or folder name disregarding upper or lower case letters by

Active@ Boot Disk User Guide
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default. In order to search for a file or folder by using the combination
of upper and lower case letters in Find What , select this check box.

. To search for files or folders based on a specified date range, select

any combination of check boxes for Created , Modified or Accessed
(Deleted) and indicate the date range.

To search for files or folders based on the size of the file, select the
Size check box and indicate the size range.

. To start the search, click Find . The status bar will display the search

in progress.

. After the search has been completed, a new tab named Search will

appear in the right pane.
Select a file or folder that you want to restore.

Click Recover . The Recovery Options dialog box will open.

1 Do the following:

1 Inthe Name field, revise the file name.

1 Inthe Recover To field, enter a path to a drive other than the
drive where you found this file or folder. You can also browse to
another drive.

I ClickRecover .

The file or folder is recovered to the new location.

_—
-j Note A device scan or a search may take a long time. To stop a device scan or

a search, click Stop at any time.

_—
-:-ANote For more detailed instructions and support, see the Active@ File Recovery

User Guide.
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3.1.5 Active@ Disk Editor

Active@ Disk Editor is a utility made to help you edit a disk's raw sector data. The editor
displays information in binary and text modes at the same time. You can use this view to
analyze the contents of data storage structure elements such as hard disks and
partitions.

The Open Disk dialog box displays a list of available storage devices and a list of logical
drives.

The Data Inspector displays whatever is currently under the cursor. It does so in ten
different formats. This may help you interpret data as displayed in Hexadecimal View If
you choose to view the Data Inspector, the window will always appear docked to the left
panel while Active@ Disk Editor.

This section contains help with the following:

Starting Active@ Disk Editor
Changing the Workspace View
Navigating to Key Sectors

1
1
1
i Editing Tools
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Starting Active@ Disk Editor

To start Active@ Disk Editor:

1 From the Active@ Boot Disk shell, clickStart > Programs > Active@ Disk
Editor . The Disk Editor will launch showing you first its Getting Started
Screen Depending on what you are looking for, you can choose to open a
Disk, File, Disk Image or browse through your computer manually.

1 ClickOpen. The Active@ Disk Editor workspace will open.

Disk Editor 5.0 x64

File View

W sppiication Log View X B My cComputer | [ Local Disk (€1 - Volume

Window

Help

x

Volume: Local Disk (C], 224 GB [NTFS] & x

H O

Fview ~ [A] ascu

Offset
0000000000
0000000010
0000000020
0000000030
0000000040
0000000050
0000000060
0000000070
0000000080
00000000350
0000000080
00000000B0
00000000C0
00000000D0
00000000ED
00000000F0
0000000100
0000000110
0000000120
0000000130
0000000140
0000000150
0000000160
0000000170
0000000180
0000000150
0000000120
00000001B0
00000001C0

l_""fx Find % Navigate } Go to Offset » Go to Sector
-

00| .-

00| ....2%..

EC|| ... .B.
13| ..
a3(| ..

00| ... _-.-h.

P ﬁ_; Eait
U| Unicode U] Browse File Entries
0 1 2 3 4 5 6 7- 8 $ A B C D E F |Unicode

[B5 52 sS0|[4E 54 46 53 20 20 20 20|[o0 02 08 0O

00 00 00 00 00 F8 00 00 3F 00 FF 00 00 08 00

00 00 00 00 80 00 80 00 FF 2F F2 1B 00 00 00 00
00 00 OCc 00 00 00 00 00 02 00 00 00 00 00 00 00
F& 00 00 00 01 00 00 00 SA 66 B4 12 71 B4 12 CB
00 00 00 00 |FA 33 CO 8E D0 BC 00 7Cc FB €8 cO 07
1F 1E 68 66 00 CB 88 16 OE 00 66 81 3E 03 00 4E
54 46 53 75 15 B4 41 BB AR 55 CD 13 72 0C 81 FB
55 aa 75 06 F7 cl 01 00 75 03 ES pD 00 1E 83

18 €8 1n 00 B4 48 Ba 16 0E 00 8B F4 16 1F CD

SF 83 c4 18 SE 58 1F 72 E1 3B 06 OB 00 75 DB

OF 00 c1 2E OF 00 04 1E 5a 33 DB B9 00 20 2B CB
€6 FF 06 11 00 03 16 OF 00 8E C2 FF 06 16 00 EB
4B 00 2B C8 77 EF B8 00 BB CD 1A 66 23 c0 75 2D
66 81 FB 54 43 50 41 75 24 81 F9 02 01 72 1E 1§
€8 07 BE 16 &8 52 11 1é €8 09 00 €6 53 €& 33 €6
55 16 16 16 68 B8 01 66 €1 OE 07 cD 1& 33 cO BF|
0n 13 B9 Fe 0C FC F3 AA ES FE 01 90 90 &€& €0 1E
06 66 Al 11 00 €6 03 06 1C 00 1E 66 68 00 00

00 €6 50 06 53 €8 01 00 €8 10 00 B4 42 82 16 0OE
00 1€ 1F 8B F4 CD 13 €6 59 5B SA 66 59 €6 59 1F
OF 82 16 00 66 FF 06 11 00 03 16 OF 00 8E C2 FF|
0E 1€ 00 75 BC 07 1F &6 €1 C3 a1 Fe 01 E8 09 00
Al FA 01 E8 03 00 F4 EB FD 8B FO AC 3C 00 74 09
B4 OE BB 07 00 cD 10 EB F2 C3 0D 0& 41 20 64 65
73 €B 20 72 &5 €1 €4 20 €5 72 72 6F 72 20 &F €3
€3 75 72 72 €5 64 00 OD OA 42 4F 4F 54 4D 47 52
20 €9 73 20 63 €F 6D 70 72 65 73 73 65 €4 00 0D
02 50 72 &5 73 73 20 43 74 72 &C 2B 41 €C 74 2B

Sector: 0(0x0)  Offset:

HName ~
4 Volume General
Volume Name
Volume letter
Volume Type
A | FileSystem
Serial Number
GUID Name
Last Formatted
Status
Scanned
4 Volume integrity info
Overall integrity status
Primary Boot Sector
Copy of Boot Sector
Primary Boot Sector matches a Copy
Primary SMFT
Primary SMFTMrt

Primary

y SRoot
Primary SBitMap
Primary SBoot
Mirror SMFT
Mirror SMFTMirr
Mirror SLogFile
Mirror SVelume
Primary MFT matches MFT Mirror

4 Volume Capacity
Total Size

4 Volume Geometry
First Sector
Total Sectors
Bytes per Sector
Cluster Size

v Get max file Size v

0 (0x0) Read Only < >

1 To browse through the content of the open ed item:

9 Click either the hexadecimal area or the text area to focus on it.

1 Use the scroll bar, keyboard arrows or the mouse wheel.

1 To toggle the focus between hexadecimal and text panes, press TAB.

Changing the Workspace View

When you start Active@ Disk Edibr, the default view shows the Info Pane on the
right and the editing pane on the left, with a Status Pane across the bottom. You
may change the default configuration of the workspace so that it opens with your

custom settings each time.

To change Active@ Disk Editor default options:

Y
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1.

4.

In Active@ Disk Editor, click View toolbar button . The drop-down list
of available views appears.

You can show or hide the Templates View, Properties View, Data
Inspector View, Bookmarks View and Find Results View at the left of the
workspace, for example for the Templates View:

9 To hide the Templates Pane, clear the Templates check box.

9 To show the Templates Pane, select the Templatescheck box, or you
can simply click on View-> Windows and click on templates

E Disk Editor 5.0 x64

File View Window Help
E Ap) Application Log  F8 hyComputer ¥ | B Local Disk [C) - Volume X
_] Windows } » Volume Local Disk (C:), 224 GB [NTFS] - Properties } Go'
| [
5 How To... Ctrl+F1
Refresh F5
v ®
e Templates
Offset 0o 1 . Bookmarks | F | Unic
0000000000 |[BB 52 9 5 -| - 0
ta Inspect

0000000010 |[00 00 O et 0
0000000020 |[[00 00 @ findResults 0

0000000030 00 00 OC 00 00 00 00 00 02 00 00 00 0O 00 00 00
0000000040 F6 00 00 00 01 00 00 00 Sh 66 B4 12 71 B4 12 c8|| &...

coooo000s0 00 00 00 00| FA 33 CO BE DO BC 00 7C FB &8 CO 07| ....
coooo000eD 1F 1E 68 66 00 CB 88 16 OE 00 66 81 3E 03 00 4E‘ f£...
To change the default size of the font in the editing pane, select a size
from the Text size drop-down list.

To toggle the display of the current address offset between hexadecimal
and decimal, from the View menu, choose Hexadecimal Offset

Navigatingto Key Sectors

To navigate to key sectors on the open item:

1 To open a different device or logical drive:

a. Click Open Disk from File menu, or press Ctrl+O . The Open Disk

dialog box appears.

b. Click a device or a logical drive to select it. Click Open .
c. The Activ e@ Disk Editor workspace appears.

9 Tojump to a named sector or offset:

a. From the Navigate menu, choose Go to Offset or Go to
Sector . The Go to Offset/Sector  dialog box appears.

b. To jump to a named offset, type the offset value as Decimal.
Use a prefix Ox to use hexadecimal values.

c. To jump to a named sector, in the Sector field, type the sector
number. To jump to a named cluster, in the Cluster field, type
the cluster number.
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d. Click Ok. The sector/offset appears in the editing panel.

1 To jump to the volume boot sector, from the Navigate menu, choose Boot
Sector (0) . The boot sector will open.

1 To jump to the partition table, from the Navigate menu, choose Partition
Table . The partition table sector appears in the editing panel.

1 To edit the partition table:

a. From the Navigate menu, choose Partition Table . Navigation will
be positioned to the sector 0, and Master Boot Record template is
applied. The Signature (55 AA) at the end of zero sector marks the
end of the Partition Table.

b. Review the settings for partition table entries 1, 2, 3and 4 in a
Template View at the left side.

c. Turn on edit mode ( Ctrl+Alt+E ) and modify partition table
parameters.

d. To save changes, clickSave.

i From the Navigate menu, you can jump to many named sectors. These
sectors are listed with the sector name and a number that is unigue to your
hard drive:

1 To jump to the unallocated boot sector, from the Navigate menu,
choose Unallocated (<your partition size>GB) > Boot Sector
(<your sector number>)

9 To jump to various primary NTFS locations, from the Navigate menu,
choose Primary NTFS (<your partition size> GB) and do one of
the following:

1 To jump to the boot sector, click Boot Sector (<your
sector number>) . The primary boot sector appears in the

editing panel.
1 Tojump to the boot sector copy, click Boot Sector Copy
(<your sector number>) . The primary boot sector copy

appears in the editing panel.

1 To jump to the MFT (Master File Table) sector, click SMFT
(<your sector number>) . The MFT sector appears n the
editing panel.

1 To jump to the MFT mirror, click $MFT Mirror (<your
sector number>) . The MFT mirror sector appears in the
editing panel.

Editing tools

You can paste code or text from the Windows Clipboard. Use these tools to copy and
paste selected code.

To use editing tools:
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1. To toggle whether or not to allow editing in the editing pane, from the Edit menu,
choose Allow Edit content

= Disk Editor 5.0 x64

File View Window Help

E Application Log View X !j My Computer X cal Disk [C) - Volume X

‘d g Back Edit - r..“fx Find %Navigate - } Go to Offset 9

[ view » [A]ascl | [U] Unicode ¥ Br ;2

offset D1 2 3 4y D E F | Unicode

0000000000 4E 54 08 00 00 1.
0000000010 00 00 00 00O 00 08 00 00| ....2%..
0000000020 | |00 00 00 00 80  Beginning of Block Ctrl+1 00 00 00| «ucunnn-
0000000030 00 00 OC 00 00 End of Block Ctrl+2 00 00 00| coeuennnn
0000000040 ||[F6 00 00 00 01  seectal Chrle A B4 12 CB| | S..vuunn
0000000050 00 00 00 00| |F2 68 CO 07| weeueuannn
0000000060 1F 1E &8 66 00 03 00 4[| £....¢.
ooooo00070 534 46 33 75 15 0C 81 FB|| --cfa--- x
0000000080 535 an 75 06 F7 g';‘-‘gFincI... Ctrl+F 1E 83 EC|| . _xa\
0000000050 18 &8 1m 00 B4 1IF CD 13| cauuen.-.
00000000R0 SF 83 c4 18 SE 75 DB B3| . .iennn..
ooooo000BO OF 00 Cl1 2E OF 20 2B C8|| ...B....
00000000CO 66 FF 06 11 00 16 00 EB|| -rnn-..
00000000D0 4B 00 2B c8 77 co 75 2D[ | K..,.-.--
00000000ED 66 81 FB 54 43 - 72 1E 16| | - cu.a" ..
00000000F0 €8 07 BE 16 68 66 53 66 é .......
0000000100 535 16 16 16 &8 Allow Edit Content  Ctrl+Alt+E 33 CO BF|| = vcvceuu--
coooo0O0110 0& 13 B9 F& OC ForIs mEE —ET FE UL IU090 66 60 1E| ....0..8

1 To select a whole area:
a. Click anywhere in a navigation view.
b. From the Edit menu, choose Select All. The whole area is selected.

1 To select part of a sector, click and drag the cursor over some code. You can
select code this way in either the HEX area or in the text area.

1 To copy HEX data, if you have already selected code in the HEX area, from
the Edit menu, choose Copy Formatted Selected HEX data is copied to the
Clipboard.

1 To copy text data, if you selected code in the text area, from the Edit menu,
choose Copy . Selected text data is copied to the Clipboard.

1 To paste data from the Clipboard:
a. Click the cursor in the area where you want to paste data.
b. From the Edit menu, choose Paste . The data appears.

1 To discard all unsaved changes (if any were made) and roll back settings to
the way they were at the last save, from the Edit menu, click Revert
Changes.

I To save changes, clickSave.

Active@ Boot Disk User Guide



'

-:-jNote By default, you cannot edit content in Active@ Disk Editor. You must
choose Allow Edit Content  in the Edit menu in order to change the
code.

—
-:-ﬁNote For more detailed instructions and support, see the Active@ Disk Editor
User Guide.
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3.1.6 Active@ Password Changer

You can use Active@ Password Changer to recover your passwords and user account
attributes in a Windows environment.

Active@ Password Changer is designed for resetting the local administrator password on
Windows systems in case the administrator's password is forgotten or lost. If such turn
of events occurs, you do not need to re -install and re-configure the operating sy stem.

This utility supports multiple hard disk drives, detects several SAM databases (if multiple
operating systems were installed on one volume) and provides the opportunity to pick
the right SAM before starting the password recovery process. It also displays a list of all
local users.

Other Windows login security restrictions can be reset, for example:
M Account is disabled
9 Password never expires
9 Account is locked out
1 User Must Crange Password at Next Logon
1 Logon Hours

With Active@ Password Changer you ca log in as a particular user with a blank
password.

Using Active@ Password Changer

To use Active@ Password Changer:

1. From the Active@ Boot Disk shell, clickStart > Programs > Active@ Password
Changer.

1 The Active@ Password Changerdialog box will appear.

&, Active@ Password Changer Professional ll

Active@ Password Changer Professional v.6.0 (buid 619)

Active@ F d Changer Professi lis a solution designed for resetting local password and account

8 attributes on Windows NT / 2000 / XP [ Vista /2003 / 2008 / Windows7 and Windows8 systems in case the
dministrators password is forgotten, lost, or a user account has been blocked, disabled or locked out. You do not
eed to re-install and re-configure the operating system in this case.

ctive @ Password Changer default settings are suitable in most cases.

Licensed to: LSoft Technologies
General License

1999-2014 (c) Active Data Recovery Software
wiww.password-changer.com

Next > Cancel
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1 Click Next , which will open the Options window offering you to cho ose how
do you want the search to be conducted.

Active@ Password Changer Professional

Select one of the options below and press the "Next” to continue:

— Cptions

& Search all volumes for Micrasoft Security Accounts Manager Database (SAM).

 Select volume with Windows Operating system manually.

= Find a folder with Windows registry files manually.

< Back | MNext = | Cancel |

a. Search all volumes for Microsoft Security Account Manager
Database 1 let Password Changer search all of your drives in order
tofind Mi crosoftds Security Data Base

b. Select volume with Windows operating system manually - if
want you can also search for the drive containing Windows system by
yourself

c. Find a folder with Windows registry files manually - if for some

reason accessing SAM databae is not possible you can find it
manually by going to this address:

1 C:/Windows/System32/Config
1 SAM hive file should be located here

Note Manually copying SAM data base is possible only when the operation is
being conducted from another operating system
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B rmasaniie
Lodm:-| | cofig ] e®meE
Name * || Date modified || Type [~ sze -]
. Journal 8/22/2013 2:25PM  File folder
Recent Places L LCE=3 3/4{20158:47 AM  File folder
& A systemprofile 7/20/20149:36 PM  File folder
E TR 7/20f20149:36 PM  File folder
o || BED-Template 3/2/2014 1:43 AM  File 256 KB
~ i_}mmpoﬂeﬂts 3/1/2015 3:54AM  File 65,280 KB
'*3 |_| COMPONENTS 8/22/2013 2:25PM  Text Document 0KB
EL | |DEFALLT 3/5/2015 10:28PM  File 256 KB
|| DEFALLT 8/22/2013 2;25PM  TextDocument 0KB
| |DRIVERS 3/1/2015 2:59PM  File 5,040 KB
| |Fe 8/22/2013 2:29PM  File 1KEB
3/5/2015 10:28PM  File 256 KB
|| SECURITY 3/5/2015 10:28PM  File 256 KB
i;jSECURJT\’ 8/22/2013 2:25PM  Text Document 0KB
|_| SOFTWARE 3/5/2015 10:28PM  File 86,272KB
,_,SOFI'WAR.E 8/22/2013 2:25PM  Text Document 0KB
| |SYSTEM 3/5/2015 10:28FM  File 14,336 KB
I_,SYFFEM 8/22/2013 2:25PM  Text Document 0KB
Fles of type: |Registry Hive (Sam) =l Cancel /l
L = %

9 Select it and click Open
I To scan the disk and detect multiple operating systems, do the following:

a. Click Search for Search all volumes for Microsoft Security Account
Manager

b. Click Next . The progress bar indicates the status of scanning. A list of
SAM hives appears.

c. Select a database from the list.
Active@ Password Changer Professional

SAM hives have been found in all drives

SAM File Path /| Size Drive File System
- C:\Windows\System32\config\ SAM 256 KB Local Diisk (C:)

4

Select target operational system SAM hive file and press the "Next” button.

Help | = Back | MNext = I Cancel

9 ClickNext . The list of users appears.
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Active@ Password Changer Professional

Users in SAM hive file at path: C:\Windows\Sstem32\config\5AM
on drive Local Disk (C2), size 224 GB, File System: NTF5

Total Users: 3

&' 0000013 Guest Built-in account for guest access to the computer/domain

Select User's Account and press the "Mext™ button.

Help | < Back | Mext = | Cancel |

1 Select a user from the list and click Next . The parameters for the selected
user appear.

Active@ Password Changer Professional

SAM file: Ch\Windows\System32\confighSAM

‘g User Name: Administrator
RID: x000007f4

Full Name I
piH Description IBuiH:—in account for administering the computer/domain
P Current State: Change to: Logon Hoursl
: r ™ User must change password at next logon
i3 I™ Password never expires
r I™ Account is disabled
] ™ Account is locked out

™ Disable Force Smart Card Login

@ [ Clear this User's Password

Disk has been opened in read-only mode.
To apply changes, exclusive lock is required.

Help | < Back | Next = I Cancel

1 Select parameter check boxes to create the situation that you want.

Click Next . A confirmation dialog box appears.

Click Yes. An information message indicates that the changes have been
made.

1 Click OK.
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1 For each user that you want to change, repeat steps 5 through 9.

-: Note For more detailed instructions and support, see the Active@ Password

Changer User Guide
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3.1.7 Active@ KillDisk

Active@ KillDisk is a powerful utility that will :
1 Wipe confidential data from an unused space on your hard drive
i Erase data from partitions or from an entire hard disk
9 Destroy data permanently

Wiping the logical drive's deleted data does not delete existing files and folders. It
processes all unoccupied drive space so that recovery ofthe previously deleted files
becomes impassible. Installed applications and existing data are not touched by this
process. Active@ KillDisk wipes unused data residue from file slack space, unused
sectors, and unused space in MTF records orsystem records.

When you erase data with Active@ KillDisk you destroy data permanently, conforming
to any one of six international standards or your own custom settings.

Wiping drive space or erasing data can take a long time, so perform these operations
when you are prepared to wait. For example, these o perations may be run overnight.

Using Active@ KillDisk

To run Active@ KillDisk:

From the Active@ Boot Diskshell, click Start > Programs > Active@ KillDisk After
initializing, the Active@ KillDisk workspace appears with all available devices Ilsted

(@ Active® KillDisk [Freeware for non-commercial use]

X
File  Actions  View  Tools  Help
e = Properties F X
%’ i B e O Name Value
Refresh File Browser  Disk Viewer
~ General
<y PhysicalDrive0 =] ~ Name Local Disk (C:)
Ready Unallocal || BACKUPS (H:) Unallocai Tree Partition
Size: 1.00 | |File System: NTFS Size: 1.82 TB Size: 1.09
ST2000VN004-2E4164. i
Serial: Z5230CZR Type: Fixed Disk Active Partition Mo
Size: 1.82 TB File System NTFS
~ Partition Geometry
&P PhysicalDrive1 = First Sector 1,026,048
S50 Ready Microsoft || Partition WSS Unallocat Offset in Sectors 1,026,048
File Systen || File System: Partition WSS Size: 112 GB. Size: 456 o
SPOCM.2SSD Size- 1601 " Segment 0
Serizl: AADOO000000000002478
Type: Fixed Dislg 55D, Dynamic Bytes per Sector 512
pr= T Total Sectors 470,537,789
g PhysicalDrive2 B | m— o e s | |||~ Local Diske (€
Ready Unallor | System | Local Disk () Unalios | 'y |[sTORAGE (D) Local C ||Unallo + Volume General
Size: 1.0 || Ale Syst [ File System: NTFS Size: 224 GB Size: 22 || g : . File Sys | |Size: 2.
INTEL SSDSC2BP480GA Si || File System: NTFS Size: 222 GB C
Serial: BTIR504405A4480BGN Sz 50 S Volume Name
Type: Fixed Disk, 5SD Size: 447 GB Volurne Letter =]
Type Volume
f-’?ﬂ PhysicalDrive3 =] File System NTFS
S5 Ready Unallocat | Microsoft | Storage space (E:) Serial Number B278-1157
Micresoft Storage Space Device Size: 40.0 | File .S;,;(wr File System: NTFS Size: 992 MB - y
ey R v Size:32.00 GUID Name W\\WVolume{5a0bacd7-0000-00
Date Formatted 12/14/2017 2:40 PM
Status Ready
:,Q’ PhysicalDrived =] Scanned No
Ready Unallocate || ACTIVE-BOOT (F:) Volume Integrity Info
P T T T Size: 1.00 1 || File System: NTFS Size: 3.75 GB « Volume Capacity L
Serizl: 8250457147714ADS997FBE 11A84( pa
Type: Removable Disk Size: 275GB Size 224 GB (240,915,347,456 bytes)
b Free Space 92.1GB
Output & X v Volume Geometry
10:33:47 ialization completed o First Sector 1,026,048
Total Sectors 470,537,788
ng disk 'Removabl Bytes per Sector 512
sk 'Remov Cluster Size 4096 bytes
Sk E  Volume Meta Data
sk MFT Position 786432 v
1isk < 5
disk
ization started v m SMART Info
NTFS] LI}
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9 Clicka physical drive or a logical drive to select it. Properties of the selected device will
appear in the Properties tab docked to the right side.

To inspect the logical drive, select it and click File Browser

toolbar button. The

Progress tab will appear, showing the status of the scan while Time Left counts down

the remaining time.

1 When the scan completes, sub-folders will appear in the System Local Disks
list and the folders and files in the selected drive appear in the Folders and

Files tab.
1

and folders will appear with a gray icon.

9 After the scan has been completed, you can:

1 Inspect existing and deleted folders and files in the Folders and Files

Available files and folders will appear with a colored icon, while d eleted files

tab.

1 View sectors of data in a device or logical drive, select a device or drive and

click Disk Viewer
the available data:

File  Actions  Edit  View Iools  Help

W) Disk Explorer 2| Local Disk (C) - Disk Viewer X

toolbar button. The Disk Viewer appears. Scroll through

Templates

B

v &2 /gj % =¥ MIFS Boot Sector ¥ Template coloring
Find Mavigate ,  File Browser
3 Name Offset

Offset 00 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15 ascII Unicode T oo
000000000000 | [EB 52 50|[4E 54 46 53 20 20 20 20|[00 02 08 00 00 | ER.NTFS  |..... doot .. ~ 0EMID 003
000000000016 | |00 00 00 00 00 F8 00 00 3F 00 FF 00 00 A8 OF 00 | ..... I B 25. . + BIOS Parsmeter Block 008
000000000032 | |00 00 00 0O 80 00 80 00  3C DE OB 1C 00 00 00 00 | ........ B N Bytes per sector 008
000000000048 | |00 00 OC 00 00 00 00 00 02 00 00 00 00 00 00 00 | . oueunonenennens | cuvmnens Sectors per cluster OIRE
000000000064 | |F6 00 00 00 01 00 00 00 57 11 78 B2 42 78 B2 AE | S.......W.x*Bx*@ | 6....... Reserved sectors 00E
000000000080 | |00 00 00 0O|[FA 33 CO 8E DO BC 00 7C FB €8 CO 07|| ....[a3A D% @hA] | ........ (always zero) 010
000000000096 | [LF 1E €8 66 00 CB 88 16 OE 00 €€ 81 3E 03 00 4E| | [ .hE.E....f£.»..N £.....! (unused) 013
000000000112 | |54 46 53 75 15 B4 41 BB A& 55 CD 13 72 0C 81 FB|| TFSu. A»2Uf.r..d | ....o.. N Medis descriptor o
000000000128 | |55 BA 75 06 ¥F C1 01 00 75 03 E9 DD 00 1E 83 B | PPu.:h..u.&%...3 | .r.._.3. “;E::;E!amck 1:
000000000144 | [1B €8 12 00 B4 48 6A 16 OE 00 8B F4 16 1F CD 13| | .h.. H.....! 5 f ........ Number of heads a
000000000160 | |9F 83 C4 18 SE 58 1F 72 EL 3B 06 0B 00 75 DB a3 |..A..X.rd;...ulg | ........ Lidden sectors oic
000000000176 | |0F 00 cl 2E OF 00 04 1E  5& 33 DB BS 00 20 2B C8|| | .A..... 230%. +§ | ...B....
000000000152 | |66 FF 06 11 00 03 16 0F 00 BE CZ FF 06 16 00 ES|| Ey........ Ag...q | .. loo. Bookmarks
000000000208 | (4B 00 2B CB 77 EF B8 00 BB CD 1A €6 23 C0 75 2D| | R.+BEwi, .»I.ffdu{ K..,.... 7 7 7
000000000224 | |66 61 FB 54 43 50 41 75 24 Bl F9 02 01 72 1E 16| | f-GTCPAuS.G-.T..| | c..ou”un T
000000000240 | |68 07 BE 16 &8 52 11 16 €8 09 00 €6 53 66 53 &6 h.».hR..h..ESESE
000000000256 | |55 16 16 1€ €8 B2 01 €6 61 OE 07 D 1A 33 CO BF| | U...h,.fa..I.34 Bookmark Offset
000000000272 | |0A 13 BS FE OC FC F3 AR E9 FE 01 50 S0 66 60 1E| | |..'5.05%&p...£°.
000000000288 | |06 66 A1 11 00 €6 03 06 1C 00 1E 66 €8 00 00 00| | | £j..f..... fh.. |
000000000304 | |00 66 50 06 53 €8 01 00 68 10 00 B4 42 8A 16 OF| | .£P.Sh..h..’B...
000000000320 |00 16 1F 8B F4 CD 13 66 59 5B SA €6 55 66 59 1F  |....of.fv[zf¥efy.
000000000336 | |OF 82 16 00 €€ FF 06 11 00 03 1€ OF 00 BE C2 FE| | | ... £fcu...... X 1 o | I e || s

Sector. 0 (0x0) Offset: 0 (0x0) |Read Only

9 View sectors of data in a file:

a.
b. Inthe right panel, select a file.
c. ClickHex Preview . The Data Viewer

available data.

Wiping Data

To clear data residue from unused sectors:
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Select a logical drive. Files and folders appear in the right panel.

appears. Scroll through the
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2. Select the check box next to a device or logical drive or multiple devices or logical

drives.

3. Click Wipe Disk toolbar button. The Wipe Disk dialog box appears.

=y Wipe Disk

[
== - . . . -
Wipe deleted (unused) data on selected partitions

&% PhysicalDrive3 Ready Microsoft Storage Space Device Type: Fixed Disk, SSD Size: 1.00 GB

Unallocat | Micros=oft | Storage space (E)
Flz Syzter || File System: NTFS Size: 992 MB

Size: 40.0

(O select all partitions

é@ Disk Wipe

i Erase Certificate
78

;ﬁ? Processing Report
4

Error Handling

£

y Press Start to begin processing

Restore Defaults

(For more about wiping methods, see Wiping or Erasing Methods
4. Chooseone of the methods from the Erase method

To change other parameters, like Certificate options click other tabs at the left

side.
6. dick Start
The Confirm Action

8. The process will be initialized with the Progress bar appearing at the lower side

of the left panel .

(O select all volumes (O select all unallocated space

Erase method: | One Pass Zeros [1 pass]

|:| Verify erasure of +  on each disk
Wipe unused clusters

Wipe metadata and system files area

|:| Wipe slack space in file clusters

D Print wipe labels for each disk using Disk Label Preset:

dialog box appears. Click Yes.

of Active@ KillDisk manual)

list.
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/ 20% total progress

Zile Actions View Tools Help

i - - Properties
[ & g = =2
g = Gg

© < = e
*fresh Erase Disk pe Disk Stop  Stop All File Browser  Disk Viewer v General

I L T 1P

Mame

PhysicalDrivel [ | s | | I T

— e
N Ready Microsot || Partition WSS Unalloc P X
|2 Fle Systs | File System: Partition WSS Size: 112 GB Size: 45¢ Active Partitic
rizl: AADDOODOD0D00000247 S S2e ey File System
pe: Fixed Disk, 55D, Dynamic v .
e Partition Geom

— First Sector
gi. PhysicalDrive2 R I—
b

o ] Offset in Sect
" Ready Unallc | Systen | Local Disk () unaik |[y | 'sToRAGE (D9 Local | Unall . .
e e e Size: 1 || Fie 5. File System: NTFS Size: 224 GB size:2 |5 | File System: NTFS Size: 222 GB File Sy ||size:2 egmen
rial: BTIR504405A4480BGN Size:% || System Disk Size:d Bytes per Sect
pe: Fixed Disk, SSD Size: 447 GB

Total Sectors

v Storage space |
PhysicalDrive3 B Wiping Storage space (E:)  progress: 20% elapsed: 00:00:00
~ Volume Gene
Busy
| _ . Volume Na
icrosoft Storage Space Device Unalloc: | Micrsot
pe: Fixed Disk, SSD Size: 1.00 GB Size: 40u || File Syste One Pass Zeros: pass 1 of 1 (0x000000000000) Volume Let
Size:32.0 20% complete  00:00:02 left
Type
File System
PhysicalDrive4 B | —
Serial Num
Ready Unalloca || ACTIVE-BOOT (F:)
B e Size: 1,00 || File Svstem: NTFS Size: 3.75 GB. 2 GUID Name
Date Formz
Dutput 8 x i
. . Status
11:01:4€ AM: Disk Wipe ~
- I —— Scanned
) : Disk Wipe
7 : Initialization completed Volume Intec
10:33:47 AM: Ready ¥ Volume Capa
10:33:47 AM: Analyzing disk 'Removable Disk 5 (\\.\PhysicalDrive5)'... Size
10:33:4€ AM: Analyzing disk 'Removable Disk 4 (\\.\PhysicalDrive4)'... Free Space
10:33:4€ AM: Analyzing disk 'Fixed Disk 3 (\\.\PhysicalDrive3)'... <

10:33:4€ AM: Analyzing disk 'Fixed Disk 2 (\\.\PhysicalDrive2)'...

9. To stop the process at any time, press ESCor click at the Stop All button near
the progress bar. You can also stop the drive wipe by pressing the little red
square near the progress bar at Local System Devices.

Erasing Data

To erase data completely:

1. Selectthe check box next to a device or logical drive or multiple devices or
multiple logical drives.

2. Click Erase Disk . The Erase Disk dialog box appears:
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= Erase Disk

r_;_i.?g
Erase data on disk within selected boundaries

# PhysicalDrive3 Ready Microsoft Storage Space Device Type: Fixed Disk, 55D Size: 1.00 GB

Unallocat || Micmsoft | Storage space (E:)

Size: 40.0 | File Syster | |File System: NTFS Size: 992 MB
Size:32.00

O Select all disk space O Select all volumes

O Select all unallocated space O Select exact disk area

ﬁ Disk Erase Erase method: | One Pass Zeros [1 pass] b

N |:| Verify erasure of > | oneach disk
«P\ Erase Certificate

ke
=X R
== rocessing Report
=4 ane
@ Error Handling [ Frint erase labels for each disk using Disk Label Preset: -

V Press Start to begin processing
Restore Defaults Show Advanced Start Cancel

(For more about erasing methods, see Wiping or Erasing Methods

Choose a method from the Erase method list.

, Active@ KillDisk manual)

If needed, set other erasing parameters by clickingon mo r e
bottom left corner .

Click Start

optinthe s é

If the Skip Confirmation check box is clear, the Confirm Action

dialog box will
appear:

. Confirm Action
= £ you

One Pass Zeros, 1 pass?

i AFE 0L SUre you want [0 erase (KL a

7l am seferted dick yeing
&) on selecied JIsK LS

=

el kY

PhysicalDrive3 Microsoft Storage Space Device 5/MN: N/A [1.00 GE]

Keyphrase: ERASE-ALL-DATA

Type keyphrase: ERASE-ALL-DATA]

Qf Click OK to continue

QK Cancel

7. This is the final step before removing data from the selected drive forever. Type
ERASE-ALL-DATA in the text box and press ENTER or click OK.

8. The process will start and the Progress bar will appear.
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9. To stop the process at any time, press ESC. You can alsoend the process by
clicking on Stop All button or by clicking on the red square at the Load System
devices panel near the progress bar of the drive that was being erased.

After the Wipe or Kill operation is complete, information about the wipe or erase session
is displayed in the Session Log :

&% Partition Partition Disk Erase 4

(i a Partition Partition Disk Erase

Doyrowr pociiffc Forifrmtoc I
oview results certificgtes gnd renorts
REVIEW FESLLLE CEFLIICOTES Orig FEporis

Results Overview | Processing Attributes Log

Title Status Errors Label Method Erase Passes
v @8 Microsoft Storage Space Device
Qf Erasing Storage space (B} Success Mo Errors 992 MB Partition NTFS One Pass Zeros 1

Qf Partition Partition Disk Erase using One Pass Zeros erase method completed successfully

;g_ Erase Certificate has been issued and can be printed Print Browse Open
% Disk Labels skipped Print Labels
v Erase Report skipped
v

E-Mail Motification skipped

Show this dialog next time

QK

Erase/Wipe Options

Verification:  In order to verify the wipe method, you will need to select the Verification
check box and set the amount of area that the utility will read in order to verify the wipe
method. Because verification is a long process, youcan specify a percentage of the
surface to be verified. To wipe or erase without verification, clear this check box.

Wipe out Deleted/Unused data: This parameter appears only when you are wiping
data from unused space on the hard drive. The wiping process clears data residue from
unoccupied space on the hard drive and does not affect installed applications or existing
data. This process contains three options:

1 Wipe unused clugers
1 Wipe Metadata/System file area
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1 Wipe slack space in file clusters

You can choose to run only one or two of these options in order to make the process
faster. If you want a thorough wiping of unused space, then include all of the options.

General Optio ns

General parameters allow you to turn features on or off or change default settings
before you erase or wipe data from an unoccupied space. You can also change the
look and feel of the application and its logging options. To view and change settings,
press the F2 key, or clickthe Pr e f e r e rromeT®ds menu.

Initialize Disk (s) after Kill /Erase : Because of the BIOS restrictions of some
manufacturers, a hard disk device that is larger than 300 MB must have an MBR (Master
Boot Record) in sector zero. If you erase sector zero and fill it with zeros or random
characters, you might find that you cannot use the hard drive after erasing the data. For
this reason KillDisk is programmed to create an empty partition table and write a typi cal
MBR in sector zero. This process is otherwise known as disk initialization.

Write Fingerprint  tothefirstsector: | f f i ngerprint has Hireten writte
sector, next time you boot from this disk, you will see a disk erase status, like this:

If by any chance the errors have occurred or the erasing has been stopped, status will
be FAILED and displayed in red color.

Save Log & Shutdown PC after completion: Erasing can take many hours. You can
leave the KillDisk working and set it to turn the computer off when erasing is completed.
A log file will be saved and can be reviewed later.

Skip Disk Erase Confirmation: The confirmation screen is the final step before
erasing data. In this screen, you type ERASEALL-DATA to confirm what is about to
happen. If Skip Confirmation is turned on, this final safety re quest will not appear. This
option is typically used with caution by advanced users in order to speed up the process.
It is safer to run KillDisk when Skip Disk Erase Confirmatio is selected by default. You
may want to use this as a safety measure to ensure that data from the correct drive
location is going to be erased completely with no possibility of future data recovery.

Ignore Disk Write Errors (bad sectors) . If this option is turned on, error messages
will not be displayed while data erasing or verification is in progress. All information
about errors will be written to the KILLDISK.LOG file. These messageswill be displayed
in the final Erasing report after the process has been completed.

Stop Process after Writing Errors: If by any chance writing errors appear during the
wipe or deletion, you can adjust after how many errors would you like the KillDisk to
terminate the process.
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Retry Attempts:  To specify the number of retries to do when an error is encountered,
enter the number in Retry Attempts.
Clear Log File before Start:  To truncate the session log before erasing or wiping

starts, select the Clear Log File before Start check box To appendt hi s sessi onés
information to the existing session log, clear the Clear Log File before Start check box.

—
-:-ﬂNote For more detailed instructions and support, see the Active@ KillDisk User
Guide.
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3.1.8 Active@ Partition Manager

Use this utility to perform maintenance tasks on hard drive partitions.

To use Active@ Partition Manager:

From the Active@ Boot Disk shell, clickStart > Programs > Active@ Partition Manager.
You will be greeted with Active@ Partition ManagerGetting Started  welcoming screen
offering you most commonly used actions for this application. Create Partition -directly
manage the unallocated space on your hard drive. Partition Manager - manage and
edit your existing partitions

To enter the Partition Manager View click on Partition Manager

To view the properties of the selected device, right click on it and choose Properties
The device properties report box appear in the right panel

To create a partition:
a. On a hard disk device, click an Unallocated area in the list to select it.

®) Active@ Partition Manager 4.0 x64 = =

File Actions View Wizards Window Help

# . - P € P,
A2 -7 g - i =
% Refresh r__d Save Hardware Info As % Create Volume (Logical Drive) [ Dﬁ; i

T iayout v = g Expand Al B Collapse Al
s Fixed Disk
=7 wm = L]
S5DSC2CW240A3 Local Disk (C:)

MBR {Basic) 224 GB Primary NTFS 1.59 ME Unallo
224GB

«p Fived Disk
T Local Disk (D2
932GB 93:3 @i Create Volume (Logical Drive)

=
&, Removable Disk O
ES Kingston DataTraveler — &
2.0 USB Device Local _
MER (Basic) 732 @ £.82 ME Unallocated
7.32G8 .

i

@ Properties F4

B Uralocted space B Frimary partition |l Active partition B Extended partition

Unallocated Space: Unallocated Space, 93.3 GB [Unallocated]

b. Click Create , which will initialize Create Partition  dialog box.
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(] Create New Partition on \\.\PhysicalDrive1

=y To create Mew Partition on Physical Disk select partition boundaries within unallocated space. Formatting and other partition
attributes are optional.

\W\PhysicalDrive1 [1953525168 sectors]

Local Disk (D)
838 GB Logical NTFS
048 195723264

Partition Geometry Partition Attributes
Maximum Partition size: 93.3 GB D Assign Drive Letter -
Sector offset: | 2048 Size, MB: | 95567 [] Format Mew Partition

|:| Measure in Sectors

New Volume will be created starting from 2048 sector with size 93.3 GB [195721216 sectors]; Drive letter will not be assigned and
partition will will not be set as Active; Volume will not be formatted;

Create Cancel Help

c. In Partition geometry, type the partition offset (in sectors) and the
partition size (in megabytes).
The maximum available size for the partition is set by default.
In Partition Attributes  , select a drive letter from the drop -down list.

f. To format this partition, select the Format New Partition check box
and set parameters for the format action.

g. Click Create. The partition is created.

1 To delete a partition:
a. Right click on a partition that you want to delete .

b. Click Delete . A message will appear asking for your confirmation.
c. ClickYes. The patrtition is deleted.

)l

1 To format a partition:
a. Right click on a partition in the list to select it and open the Partition
Manager Menu

b. By choosing Format , you will launch the Format Partition window box .
& Format Partition - Local Disk (D)

= Format volume with selected File System and
Allocation size unit. Volume label is optional.

Wolume label:
File System: MTFS "% Allocation unit size: | 2048 -

Perform a quick format

Format Cancel

c. Give the partition a volume label in Volume Label
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d. Select a file system type in the File System drop-down list.
e. Select an allocation unit size in the Allocation unit size  drop-down list.

f. To perform a quick format, select the Perform a quick format check
box.

g. To perform a full format, clear the Perform a quick format check box.
h. Click OK, the process will be initialized and the progress bar will appear.

T

1 To change the letter for a device or volume:
a. Selecta device or a volume and right click on it.

b. Click Change Attributes . The Partition Attributes dialog box appears
with the first available letter selected.

2] Partition Attributes
e Chenge drive letter and volume label for
@ selected drive.
(®) Assign the following drive letter: | D -

'3:::1' Do not assign a drive letter

Volume Label:

oK Cancel

c. To change the drive letter, select a letter from the Assign the following
driv e letter drop-down list.

d. Click OK. The letter is assigned.

A
; Note For more detailed instructions and support, see the Active@ Partition
Manager User Guide.
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3.1.9 Active@ Disk Monitor

Monitor the reliability status of your local hard drives to help prevent data loss due to
hard drive failure. Use this utility to perform maintenance tasks on hard drives in the
system.

A Note This is the free version of this utility and some functions are disabled.

Some functions that are enabled apply only when using the stand-alone
version of Active @ Hard Disk Monitor.

To use Active@ Hard Disk Monitor:
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1. From the Active@ Boot Disk shell, clickStart > Programs > Active@ Hard Disk
Monitor. The Active@ Hard Disk Monitorworkspace appears.

[] Active@ Hard Disk Monitor Build 3.2.2

=10 x|

File Tasks Help
o r @
About

Refresh  Preferences

& Local System Disks | @ = Attribute Name Value

% INTEL 55DSC2CW 24043 Mot supported E| 5 Disk details Hard Disk 0

..... = Disk Model INTEL SSDSC2CW 24043
a & SAMSUNG HD10351 o Serial Number CVCV21210072240CGN
Firmware Version 400i
User Capadty 240 057 409 536 bytes (223.571 GB)
ATA Version 9
ATA Standart
: SMART Support Enabled
[+ = Volumes on the disk 1
. % (C:) Free 30,275 GB of 223,568 GB File system (NTFS). Serial number (12B4-665A).
=l .o Advanced disk information
- Cylinders 29185
- Tracks per cylinder 255
- Sectors per track 63
- Bytes per sector 512
[#- Offfine data collection status 0x0000
[+ Offline data collection capabilities 0x007F
[#- SMART capabilities 0x0003

-+ SMART Attributes Data Structure revision number 19

® DiskInfo | © SMARTInfo | ! ScenDisk | [ Eventlog | . Statistics |

—Disk Status [Last Checked: 2015-03-09 00:54:52] Temperature —) —Volumes [Last Checked: 2015-03-09 00:54:52]

Q/ Health Status: 0K

: Mod:t INTEL SSDSC2CW240A3 e Volume | Label | File System | capacity | Used Space |
Work Time: 322106205 years 9 months 27 days X N 95:% ;1_93 293 GB,
. 13 hours. (2821650362341 hours) Verifying ([ NTFS 223,368 GB :

1 2. To change the settings of the utility, click Preferences .
e. When the Preferences dialog box appears, do the following:

a. Inthe Poll settings tab:
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x

4 Poll settings | .4 Environment I 0 Notification settings |
Check every I 5 i’ IMinute(s) ﬂ
Check Free Disk Space every I 10 ﬁ IMinuhe(s) j
—\Warning ]
Temperature threshold 55 Cf131F | |
Run an external Task |
—Critical 7
Temperature threshald 70 Cf158 F ]
Run an external Task |
I~ | Enzble at Windows startup
I~ show Temperature in Tray Diisk I\';a, ID 0 [INTEL 5505C2CW240A3] j
Ok | | Cancel I

b. To change the frequency for checking status of the device, make changes
in the Check every fields.

c. To change the frequency for checking the amount of free disk space,
make changes in the Check Free Disk Space every fields.

d. To show which disk to monitor, choose it from the Disk drop-down list.
In the Environment tab:

]
+i Poll settings 2.4 Environment | 0 MNotification settings I
—Additional options
Show temperature in IFahrenheit j
Language IEninsh j
Style I'\ﬂrindoux'sl-'ista j
—Traylcon color
Normal I M Green j
Warning I Yellow j
Critical I B Red j
Ok I | Cancel l

f.  To change how drive temperature is displayed, choose a different setting
in the Show temperature in  drop-down list.

g. To change the appearance of the workspace, choose a different setting in
the Style drop-down list.

From the Local System Disks list, click a device to select it. Information a bout
the selected device will be shown in the right panel.

To display attributes about the device, click the Basic Info tab. Attributes appear
in the panel.
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[[] Active@ Hard Disk Monitor Build 3.2.2

File Tasks Help

~=lol x|

® E @

Refresh  Preferences About
4 Local System Disks | d - | Attribute Mame value
INTEL SSDSC2CW240A3 Mot supported - % Disk details Hard Disk 0
SAMSUNG HD 10351 91 - Disk Model INTEL SSDSC2CW240A3
@ ‘) - Serial Mumber CYCV21210072240CGN
irmware Version 400§

[ Disk Status [Last Checked: 2015-03-09 00:54:52]
Model: INTEL SSDSC2CW240A3

Health Status: 0K

- User Capadity
ATA Version
- ATA Standart
- SMART Support
Volumes on the disk
- (Ct) Free 30.275 GB of 223.563 GB
Advanced disk information

240 057 409 536 bytes (223,571 GEB)
9

Enabled

1
File system (NTFS). Serial number (12B4-6654).

i

- Cylinders 29185
Tracks per cylinder 255
-+ Sectors per track 63
- Bytes per sector 512
[ Offline data collection status 0x0000
[+ Offline data collection capabilities 0x007F
[+ SMART capabilities 0x0003

~SMART Attributes Data Structure revision number 19

Work Time: 322106205 years 9 months 27 days
13 hours. (2821550352941 hours) Verifying

® DickInfo | @ SMARTInfo | 1 ScanDisk | . Eventlog | . Statistics |

[Volumes [Last Checked: 2015-03-09 00:54:52]

Volume |Labe{| File System | Capadity |
=1} NTFS 223,568 GB [

Temperature

Used Space
B6%: (153.253 GB} |

4. To display SMART attributes, click the SMART Info tab. Performance and health
attributes appear in the panel.

[=] Active@ Hard Disk Monitor Build 3.2.2

=10l x|

File Tasks Help
® E 6
About

Refresh  Preferences

L7 Local System Disks

supported

@ & SAMSUNG HD1035)

—Disk Status [Last Checked: 2015-03-09 00:56:57]
Model: INTEL SSDSC2CW240A3

Health Status: 0K

D | Attribute Name I Value I Raw Value | WOrstI Threshold I Status I;
5 @ Reallocat=d sector count 100 0 100 0
9 @ Power-on hours count 0 7C34000DCo8E 0 0
12 @ Power cyde count 100 3FC 100 0
170 ) Unknown atirbute 100 0 10 10 ] 100%
171 @ Unknown attribute 100 0 100 0
172 @ Unknown attribute 100 0 100 0
174 @ Unknown attribute 100 F4 100 0
184 4 Unknown attribute 100 0 100 50 [ ) 100%
187 @ Unknown attribute 100 i} 100 0
192 @ Power-off retract count 100 3F4 100 0 ||
225 §® Load/Unload cyde count 100 53405 100 0
226 € Load-in time 100 FFFF 100 0
227 €% Torque amplification count 100 39 100 0
228 @ Power-offretract count 100 FFFF 100 0
232 ) Unknown attribute 100 0 100 1 — 100% ~ |
I tj Health attribute. rf:‘\t Health/Perfomance attribute. Gd Perfomance attribute. o Information attribute.
Description
~
0 Count of reallocated sectors, When the hard drive finds a read fwritefverification errar, it marks this sector as
"reallocated” and transfers data to a spedal reserved area (spare area). This process is also known as remapping and
“reallocated” sectors are called remaps. This is why, on modern hard disks, "bad blocks™ cannot be found while testing the d
T S T o g R Ty Sy i B S
© DiskInfo @ SMARTInfo | . ScanDisk | ./ Eventlog | . Statistics |

Work Time: 15589358566 years 11 months 12
days 11 hours. {136562781046379 hours)

Temperature

—Volumes [Last Checked: 2015-03-09 00:54:52]

Violume ILabell File System I Capadity | Used Space |
) NTFS 223,568 GB [ ]

5. To scan the selected devicefor bad blocks, click the Scan Disk tab and do the

following:
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[ Active@ Hard Disk Monitor Build 3.2.2 =[]

File Tasks Help
®& B @
About

” Refresh  Preferences

Verified block
B Gadblock
W  Elock being verified

Check Block Size
’7(" 512 bytes (1 sector)

a | Legend
’7 Unverified block

e 64Kb (128 sectors)
(256 Kb (512 sectors)

From sector | 3:
Tosector 458862127 3:

1 Startscan
4, Stop scan
Ad
© DiskInfo | € SMART Info 1scanDisk | [ Eventlog | . Statistics |
Disk Status [Last Checked: 2015-03-09 00:56:57] — |~ Temperature — —Volumes [Last Checked: 2015-03-09 00:54:52]
@ "M:t INTEL SSDSC2CW240A3 i an Volume I Label | File System | Capacdity | Used Space
Work Time: 15589358566 years 11 months 12 N n Se9: (153,293 GB|
days 11 hours. (13656278 1046379 hours) # = cl NTFS 223.568.GA [ L I
5. Health Status: 0K
i) =

1 To change the block size, in the Check Block Size area, choose one of
the three options.

1 To specify a start sector and a stop sector for the scan, type the sector
numbers in the From sector and To sector fields.

9 Click Start Scan . The process wil start indicating the progress in the bar.
I To stop the scan at any time, click Stop Scan .

1 After the scan is complete, the Scan Disk Complete message boxwill
appear with the scan details.

1 To view a list of events run in the session, click Event Log . A list of
events appears in the panel.

S
-:-jNote For more detailed instructions and support, see the Active@ Disk Monitor
User Guide
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3.2 Network

This section describes the following:

Map Network Drive - A Mapped Drive is typically a place on a networkd server hard
drive that has been created or designated as a shared folder and assigned a local drive
letter. The drive has been awarded with specific permissions of use as the folder will
store information for particular users or groups.

Network Configurator - In computer networking, the ARP (Address Resolution
Protocol) is the method for finding the host's hardware address when only its network
layer address is known. Use the Network Configurator utility to configure TCPAP and
Windows firewall settings.

Remote Desktop Connection i Being the integral part of Microsoft Terminal Services,
you can use this utility to allow a remote user to take control of your computer (Remote
Desktop Client). Microsoft provides the client software Remote Desktop Connection for
most Windows operating systems that allows users to connect and work with a remote
server running Terminal Services.
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3.2.1 Map Network Drive
To map a network drive:

1. From the Active@ Boot Disk shell, clickStart > Network > Map Network
Drive . The Map Network Drive  dialog box appears.

2. In Drive , select a drive letter to be assigned.

fu Map Network Drive ==
What netwok folder would you like to map?
Spedify the drive letter for the connection and the folder that you want to connect to:
Drive: K: -
Folder: \\1592.168. 1. 20'MyShare v

Username: Userl

Password: snees|

Connect Cancel

3. In Folder , type the server and share the name of computer or folder you want.
For example: \\servername\sharename.

4. To search for the computer or folder, click Browse button [ é ]

If it is necessary to change the user name in order to map the selected drive, do
the following:

a. Enter the domain name and the user name that has a permission to
connect to the selected computer or folder.

b. Enter the password for the user named above.

6. Click Connect

'

-:-ANote Mapped drives are available only when the host computer is available.
Network drives are assigned letters from Z to A, and local drives (your
hard drive and removable storage devices) are assigned letters from A to
Z. You can assign a computer or shared folder to a different drive letter
by disconnecting from the drive and then reassigning it to a new drive
letter.
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3.2.3 Network Configurator

This utility works only on computers with adapters that are configured to obtain an IP
address automatically. It renews DHCP configuration for all adapters.

To configure the IP address:

1. From the Active@ Boot Diskshell, click Start > Network > Network
Configurator

2. The Network Configurator dialog box appears.

» Network Configurator (=3
O & O

Ethernet Adapters

’D ¥ Intel(R) PRO/1000 MT Network Connection -

P & ons ,'? Network Identification Eéi Firewall

(®) Obtain an IP address automatically h

() Use the following IP address: MAC Address: 00-0C-29-79-AD-85
Operation status: Connected

- | Network Connection: Ethernetl
DHCP Enabled: Ves

| DHCP Server: 192.168.152.254

. | IP Address B
Subnet Ma
Default Gatew
DMS Server: 192.168.152.2
I i <vcll: On

IP Address:

3. If network service has not been started at boot up time, start it by clicking toolbar
button Initialize Network .

From the Ethernet Adapters  drop-down list, select an adaptor.

5. To view details about the selected adaptor, hover the mouse over the Ethernet
Adapters field. A drop-down text screen will appear.

6. Inthe IP tab, do the following:

9 To get an IP address automatically from the network server, select the Obtain
an IP address automatically radio button.

1 To use a specific IP address, select the Use the following IP address radio
button and type the information in the fields below.

7. Inthe DNS tab, do the fol lowing:

9 To get a DNSautomatically from the network server, select the Obtain DNS
Server address automatically  radio button.

1 To use a specific DNS address, select the Use the following DNS Server
address radio button and type the information in the fields below.

8. Inthe Network Identification tab , to specify a workgroup for group access, type
the workgroup name in the Workgroup field and click Set.

9. Inthe Firewall tab, you can set the status of the firewall in the Firewall status
drop-down list:
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9 To turn the firewall on, choose On.

9 To turn the firewall off, choose Off.
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3.2.3 Remote Desktop Connection

To use this utility, Remote Access Service must be installed and running on the
server you want to connect to .

Use the Active@ Boot DiskView Network Status utility to ensure that your client
computer has an active network connection.

To connect to another computer using Remote Desktop Connection:

1. From the Active@ Boot Disk shell, clickStart > Network > Remote Desktop
Connection. The Remote Desktop Connecton dialog box will appear:

=101 ]

H Remote Desktop Connection

Computer: || ﬂ
Connect I Cancel | Help | Dptinns>>|

2. Inthe Computer field, type the URL for the home directory of the Web server
hosting Remote Desktop Web Connection.

3. To set more parameters for the connection, click Options >>  and specify
information for your connection.

4. ClickConnect .
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3.3 Utilities

Use these utilities to perform different support tasks.

Explore My Computer T Use Boot Disk Explorer to access the file system. Browse,
copy, move and delete files and folders. Burn data to CD/DVD discs.

7-Zip File Manager 1 powerful file manager, supports access to nearly all file archives.
Packing and unpacking: 7z, XZ, BZIP2, GZIP, TAR, ZIP and WIMUnpacking only: ARJ,
CAB, CHM, CPIO, CramFS, DEB, DMG, FAT, HFS, ISO, LZH, LZMA, MBR, MSI, NSIS,
NTFS, RAR, RPM, SquashFS,bF, VHD, WIM, XAR and Z file formats.

Notepad Text Editor i When you are performing maintenance on a hard disk or if you
are repairing or recovering lost or damaged data on a disk, you might want to record
technical information about the disk before making changes. This information can prove
to be helpful if you ne ed to remember the original configuration when restoring data
after a system crash or when contacting technical support.

Calculator 7 A calculation application included with Microsoft Windows.

Honeyview Image Viewer - is a very fast image viewer supporting various picture
formats (BMP, JPG, GIF, PNG, PSD, DDS, JXR, WebP, J2K2JPGA, TIFF, PCX, PNM,
PPM,BPQ, including camera raw images (DNG, CR2, CRW, NE, NRW, ORF, RW2, PEF,
SR2,RABR.

SumatraPDF Document Viewer - is a fast, minimalistic PDF, XPS,DjVu, CHM, CBZ
and CBRdocument reader with no external dependencies.

Registry Editor 1 View and edit registry information in the current operating system.
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3.3.1 Explore My Computer

Boot Disk Explorer is a fast, small, compact and innovative file manager, similar to
Windows Explorer.

Boot Disk Explorer

P *BRIEO @

Address: ®

= My Computer Mame Size Date Maodifie

=4 Removable Disk (A | Program Files 81.22 MB File Folder ~ 4/17/20159:2

» a Local Disk [C:) . Program Files (x26) 23.54 KB File Folder  4/2/2015 419
> e DVD_ROM (D:) . ProgramData 1.22MB File Folder  8/22/2013 8:2
| Boot (X:) , Users 294 ME File Folder 8/22/2013 8:4

+ CD/DVD Burner basket | Windows 99.44 MB File Folder  4/9/2015 2:00
|| SWIMDESC 1.87KB File 44972015 2:00

|| BOOTDISK.KEY 70 bytes KEY File 3/27/2015 112

2| Unattend.xml 613 bytes xml File 4/22/2015 5:1.

< >

Boot Disk Explorer has some additional featurest hat c¢ an 6ibh Wibdewsf oun d
Explorer:

9 Displays the total size of each folder.
1 Allows you to browse folders from a tree-view \ list-view interface.

1 Youcan map an FTP serveras a drive letter, the same way that you would map a
network drive using buttons on the toolbar.

1 When you copy a file, the progress bar will provide you with the information about
the ongoing process

9 Using ZDelete toolbar button, you can permanently destroy selected files and
folders permanently.

9 Using Burn Disk toolbar button, you can burn data files and folders from CD/DVD
Burner basket
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3.3.2 7 -Zip File Manager

7-Zip is a file archiver with a high est compression ratio. Usually, 7-Zip compresses to 7z
format 30-70% better than to zip format.

7-Zip File Manager 1 two panel file manager, being able to browse, preview, copy,
move, rename and delete files and folders, as well as create and de-compress file
archives of different formats.

It is an open source software, most of the source code is under the GNU LGPL license
X:\Program Files\BOOTDISK\ =5 e

File Edit View Favorites Tools Help

b om v o ow X i

Add  Extract Test Copy Move Delete Info

5 ca G\ vl . ¥:\Program Files\BOOTDISK, v
MName Size Modified Cre * || Name Size  Modified Create *
 SRECYCLE.BIN 2015-04-16 08:16 201 . shell_pic 2015-04-19 08:45 2015+
. bin 2015-04-0108:43 201 IT Autorun.exe 631808 2015-04-1012:33 2015+
Common Files 2015-03-3013:07 201 @ bootBurnDataCD.... 292 352 2015-03-23 16:16  2015-(
docs bR TR M T BootDisk pdf | 680150 2014-10-16 11:54 | 20154
. Forensic 2015-03-30 13:24 201 [% CheckDisk.exe 226304 2015-03-23 1617 2015+
I Help 2015-03-30 1303 201 | data_shell.cfg 9281 2015-04-10 1431 2015-(
HexEditor 2015-03-30 13:03 201 7] DiskEditor.exe 9186816 2015-04-19 08:43 2015-(

J Kernel 2015-03-301:03 201 (e DiskEditor.pdf 1313639 2014-10-17 0&:08  2015-(

. KillDisk-Freeware 2015-03-3013:03 201 B8 DiskMonitor.exe 1666872 2014-10-20 10:07  2015-(

s lib 2015-03-30 13:04 201 f¥ DiskMonitor.pdf 1428901 2009-04-17 09:23  2015-(
Linusx 2015-03-3111:07 201 5 DisplayRes.exe 41472 2015-04-06 09:54  2015-(

. PartitionManager 2015-03-3013:03 201 M Eplorer.exe 860 672 2015-04-1511:07  2015-(
| pics 2015-03-3113:08 201 v || i FilePreview.exe 1336832 2015-03-251315 2015-( w

< > < >
4 object(s) selected 0 0 2015-03 1 object(s) selected 689 150 689 150 2014-1

Main features:
1 High compression ratio in 7z format with LZMA and LZMA2 compression
1 Supported formats:
o Packing / unpacking: 7z, XZ, BZIP2, GZIP, TAR, ZIPand WIM

o0 Unpacking only: ARJ, CAB, CHM, CPIO, CramFS, DEB, DMG, FAT, HFS,
ISO, LZH, LZMA, MBR, MSI, NSIS, NTFS, RAR, RPM, SquashFS, UDF,
VHD, WIM, XAR and Z.

1 For ZIP and GZIP formats, 7-Zip provides a compression ratio that is 2-10 %
better than the ratio p rovided by PKZip and WinZip

Strong AES256 encryption in 7z and ZIP formats
Self-extracting capability for 7z format

Integration with Windows Shell

Powerful File Manager

= =4 -4 -4 -2

Powerful command line version
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3.3.3 Notepad Text Editor

Notepad is a simple text editor for Microsoft Windows and a basic text-editing program
that you can use to create documents.

£ wpeinit - Notepad (o2 s
File Edit Format View Help

2015-84-21 18:30:48.318, Info WPEINIT is processing the unattend file
2015-84-21 18:30:48.358, Info ==== Initializing Display Settings ===
2015-84-21 18:30:48.358, Info Setting display resolution 1024x768x32(

2015-04-21 10:30:48.358, Info [STATUS: SUCCESS (8xB8peanes)

Notepad is a common text-only (plain text) editor. The resulting files o typically saved
with the .txt extension & have no format tags or styles, making the prog ram suitable for
editing system files to use in a DOS environment and, occasionally, source code for later
compilation or execution, usually through a command prompt. It is also useful for its
negligible use of system resources; making for quick load time and processing time,
especially on under-powered hardware. Notepad supports both left-to-right and right -to-
left based languages. Notepad does not treat newlines in Unix- or Mac-style text files
correctly. Notepad offers only the most basic text manipulati on functions, such as
finding and replacing text.

82 Active@ Boot Disk User Guide



3.3.4 Calculator

Calculator is a software calculator included in all versions of Windows.

= Calculator

View Edit Help

aeee aaee aeee
B3
2668 Ba88 2886
31
(JHex Mod
[ ]
()Bin Rol || RoR
ar Xor
Lsh Rsh
Mot || And

When Calculator runs in standard mode, it resembles a four-function calculator. More
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M=
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32
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advanced functions are avaiable in scientific mode, including logarithms, numerical base

conversions, some logical operators, operator precedence, radian, degree and radians
support as well as simple single-variable statistical functions. Separate programmer,
statistics, unit conversion, date calculation and worksheets modes were also added to

help different types of users solving specific tasks.
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3.3. 5 Honeyview Image Viewer

Honeyview Image Viewer provides ultrafast rendering with optimized image processing.

o’o pics = WelcomeFax.tif [5/5] - Honeyview 5.11

B3 ExiF [[ I Viewv Slideshow v Bookmark v Edit¥ Copytow Lock (@

Features

1 Support for Various Image Formats - BMP, JPG, GIF/Animation GIF, TIFF, PNG,
TGA, PSD, JPEG 2000(JP2, J2K), JPEG XR/HD Ph¢dXR, WDP, HDP), Adobe
Digital Negative(DNG), DDS, WebP, and PCX formats are supported.

91 Direct View for Compressed Files- Images can be viewed without extracting (but
with memory decompressing) compressed files (ZIP/CBZ, RAR/CBR, ALZ, EGG,
LZH, TAR, 7Z, HV3, CAB, and ISO).

1 EXIF View- Click the "EXIF" button in the upper -left corner to display EXIF
information along with the file information .

1 GPS View- Many smartphone photos (taken by iPhone or Galaxys) include GPS
information. It displays GPS information of a photo on Google Maps.

1 Slideshow View- Click the [Slideshow] button on the top of the window to start a
slideshow with the currently displayed pictures at a certain interval (1790 sec).

1 Add/Edit Bookmarks - Click the [Bookmark] button on the top of the window to
go to frequently viewed images.

1 Copy/Move to Photo folder - Click the [Photo folder] button in the upper -right
corner to copy/move the currently displayed photo to [Photo folder 1] or [Photo
folder 2].

1 Support for Keyboard Shortcuts - Honeyview supports many keyboard shortcuts
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Support for Sound & Shot Files - Honeyview supports Sound & Shot files and the
audio file to which image and sound is simultaneously recorded.

Fast Image Processing- Optimized image processing provides faster image
loading and filtering than competitors

Support for Unicode - Unicode is supported to fully display Chinese, Russian,
Japanese, etc., in foreign-language Windows.

Auto Image Rotation - With EXIF information, Honeyview automatically rotates a
picture to the correct position.

Support for 64-bit OSes - Honeyview fully supports 64-bit OSes for faster
processing.
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3.3.6 Sumatr aPDF Document Viewer

SumatraPDF is an open source PDF eader for Microsoft Windows. The program also
opens Open XML Paper Specification, DjVu, EPUB, XPS, FB2, CHM, CB7 CBR CBT CBZ,
MOBI and PRC files.

= BootDisk pof x| [E=RE=N =
\E.§,|Page: 4 /73 \,—':‘,|‘ﬁ'}a ‘9&)|Find:| 4 b %
x

Bookmarks
=% 1 Product Overview ~
E| 1.1 About Active@ Boot Disk 1 Product Overview

: i 1.1.1 About Active@ Boot Di
El 1.2 Requirements for Using Activ

This chiagetie ghoiss an cvandiow of Asthoid Bst Disk,

1.1 About Actived Boot Disk

H Lo 1.41 How the system RAM it Pectivadd Bioon ik 15 @ povearful g o ik that wil Baip wouin 2 s of
: . . datz recovery and deka secuiby scenarics.
(=) 1.3 Downloading and Creating £ Activeds Bout Dk combines & romber of powesful tnoks thet ket you necover
. . o data, et Windirws PASSRONCS, ke COM I ber SPRem backaps and
2o 1.3.1 Active® Boot Disk Crez mr:yua;amla.maz-amlDu;tu—.smm-,m:ﬂnwu-mmm
from 2 boatable COOVEYED Disc or USS Fizsh Media
2. 1.3.2 Burn the |50 to a boota Wesar you ube Actiood Boot Disk, i gain SCCRSS 10 B0 &S &R 09 3
) . ] physkcal kevel, 2nd on 2 kgical s, bypassing the reskient nposating
- 1.4 BootDisk_Drivers and BootDi sysem. ected ohames for pour
: i

- residn Create 3 "chean” Sata hackup of
--1.53 Booting frem a CD, DVD or L —— —
. 5 5 H Wity I i ot LS casnol b beckad by
-2 Mavigating the Active® Boot Disk e e, The ey i st
: the target iocation. 1F & s snother sppication gens acoess 50 the
= 2.1 Start button menu [ it reer e Fikes bt o ane Srying to necmeer,
: renndering thrm unsedreea bie.
.. 2.1.1 Other start button featy Here ore same ofher fusctions that you can gerform by bodting from the
. . CINDVDAISE
- 2.2 Quick launch icons Backup the systom diive - [T you back up the system drive with Windows
. sarte freem D) cama drise, mban you restnm e hackep, il Sarts as
[=)- 2.3 Systern utility icons hough wou ans recovieing from & ess of pawar. The Boct ug siais with
B SRR inkageity Chocking. I vou back up the Sy@em drive with Windows
Lo Virtual Keyboard starbed from am ederal dove, e restoed system siarts deon
Wipe ursed data from e system records and directories, from MFT (20
i Screenshot PTFS), From wnused chostars, Sum i siack spece {sms Actvei KI1Dik -
A “dean”™ mpe opesalion & not possble with Wisdows steried Som the
e same drive. ¥ pou wipe cata with WINCowS started from an extenal
=13 Programs and utilities Tive the e me s el

Dickete s - IF yiou dedche files with Wirdows startod from th same:
drives, Volame Shado Cooy serioe mey =Hl be active, keepng the
rvicus varsien of this ik e e 3 ssapshet of the wealk ik, 11 &

El 3.1 Programs

3.1.1 Active® Disk Image pasaibic thak an unlowitod ininuder may retrieve ths confidensialcata, I
3.1.2 Actlve@ Data CDIII‘DVD Ru_::;"}:!‘ﬁnmwnﬂnlmmﬂmﬂ'\mu“ drive, the Solee &
i . " A2ty Bock Disk Contains the folksiieg productsand utikes:

3.1.3 Active@ Partition Reco At Dk Emage

‘.. 3.1.4 Active® File Recovery

.3.1.5 Active® Disk Editor
{34 R Artine Dacownrd Cha *

Sumatra has a minimalistic design, with its simplicity attained at the expense of
extensive features. For rendering PDFs it uses the MuPDF library.Sumatra was designed
for portable use, as it consists of one single file with no external dependencies, making it
usable from an external USB drive

When re-opening a document, the rotation, zoom, window size, page, etc. are
remembered from the last time that document was opened, making it behave more like
an e-book reader than some other PDF viewers

Sumatra does not lock the PDF file. Without closing the PDF file, a user can save over
the PDF and then press the R key to refresh the PDF document. For example, a user
could find this feature useful when, after recompiling the altered TeX source code,
simply pressing 'R' and view the altered document.
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3.3. 7 Regqistry Editor

You can review and change local registry parameters after loading a registry hive from
any partition that is detected by Active@ Boot Disk utilities. If your computer cannot
complete a boot-up and if the boot failure is related to registry parameters of a driver or
another bootable configuration, you may still be able to fix it by changing registry
parameters using Registry Editor.

To use Registry Editor:

1.

In order to launch Registry Editor from the Active@ Boot Disk shell, click on
Start > Utilities > Registry Editor

In the registry hierarchy list, choose either HKEY_ LOCAL_MACHINE or
HKEY_USERS hive.

3. From the File menu, chooseL oad Hi veé

4. The Load Hive dialog box appears.

5. Browse to the primary logical drive (for example, C:) and navigate to

Windows \ System32 \ config where you will find the contents of the config
folder.

Choose a registry hive. For example choose one of:
1 SYSTEM
1 COMPONENTS
1 SOFTWARE

7. Click Open, which will open the Load Hive dialog box.

10.

11.

12.

In Key Name , type a custom name for the hi ve that you are loading. For
example MY_SOFTWARE_HIVE.

Load Hive

Key Name:
MY_SOFTWARE_HIVE

Cancel

Click OK. The new hive will appear in the registry hierarchy under the root level
that you have previously selected in step 2.

Open the loaded hive in order to view and edit registry values, create and delete
new entries or keys.

After you have completed all the changes in the loaded hive, close the Registry
Editor. All changes are written to the registry hive that was previously attached.

Exit Active@ Boot Disk and restart the computer.
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3.4 System

Many of these utilities are familiar Windows functions. With Active@ Boot Disk, you can
access them even if your hard drive is damaged.

System Information i Displays system information about your local machine.

Check Local Disks 1 An applet that helps you create and display a status report for
your hard drive.

Display Settings i Choose the resolution and number of colors displayed.

Task Manager 1 Get information about computer performance and details about
running applications, processes, network activity, user and system services. View or
modify currently running services. View the full name of a process. Monitor applications
and services running system performance and resources.

Set Date, Time &Zone i Change your computerés date, ti me

Local Registry Search Utility T Search for and display specified registry details or
create a custom registry hive. After you find the registry hi ve that you are looking for,
you can edit it with Registry Editor.

Add Language & Keyboard i Add language support for a second language. This
includes special keyboard layout and the ability to display language characters on the
screen. You can use a different language for a file name or when recording notes about
changes made to the system.

Bootable Configuration Editor T View and edit entries in BCD (Boot Configuration
Data) store to make a Windows system partition bootable
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3.4. 1 System Information

This utility displays in-depth details about your local system.

To open System Information:

1.

In the Active@ Boot Disk shell, click Start > System > System Information
The SysiInfo display box appears.

-icix

Ml OS Mame Windows (TM) Code Name “Longhorn” Preinstallation Environment
Version 6.1 Service Pack 1 Build 7601
System Name MININT-22PK3AZ

Display BIOS Version/Date ALASKA - 1072009 BIOS Date: 012914 11:31:15 Ver: 18.0201/29/...
----- Drives System Type %86 Family 6 Model 60 Stepping 3
- Metwork Processor Intel(R) Core(TM) i7-4770K CPU @ 3.50GHz
Windows Directory ¥:\windows
System Directory X:\windows\system32
Total Physical Memary (RAM) 15.94GB
Available Physical Memary 15.28 GB

After the SysInfo screen appears, system information details appear in six categories:

1
T

1
T

System Summaryi Operating system, BIOS, Processor, RAM and more.

Installed Devicesi All classes of devices, including batteries, drives, human
interface devices, controllers, etc.

Environment Variables i Processor architecture, revision number, as well as paths
to various tools and operating system utilities.

Display i Current and available display resolutions.
Drives 1 Information about local fixed disks, including amount of free spa ce.

Network 1 IP configuration and specifications for LAN adaptor.

To save all system information to an HTML file:

1.
2.
3.

Click Save Sysinfo to file . The Save dialog box appears.
Navigate to the folder where you want to save the information.

Name the file in File name and click Save.

89



3.4.2 Check Local Disk s

CheckLocal Disks is an applet that will help you create and display a status report for
your hard drive. The applet also lists and corrects error on the disk.

Similar to Windows CHKDSK, Check Disk has a lisbf parameters that help you perform

various functions on your hard drive.

To use Check Disk:

1. Inthe Active@ Boot Disk shell, click Start > System

1 The Check Disk Applet
the Local Disks list.

i@ Check Disk Applet

O e CTIvE BOOT(F)
[ & Local Disk (D:)
[ = Boot {x:)

FAT [FAT32 only: Specdifies the files to check for fragmentation

> Check Disk .

workspace will appear with a list of all hard drives in

x|
I F

[ |
N

Fixes errors on the disk.

On FAT/FAT32: Displays the full path and
name of every file on the disk.

On NTFS: Displays deanup messages if any.

4

/R

Locates bad sectors and recovers readable
information.

[~ /1 [NTFS only]
Perf\:urms a less vigorous check offindex
eniries.

[~ jc [NTFS only]
Skips checklnu of cydes within the folder
structure.

I Browse |

% Addalimarkedidisis || o Addfle

€5 Delete command - |

Application |

Parameters

|
) Execute |

2. To select a hard drive, select the check box next to the drive6 same.

3. You can add parameters to the command:

9 /F i If an error is encountered, Check Disk will fix the issue that causes the

error.

1/V 7 OnaFAT or FAT32 file system, the full path and name of every file is
displayed. On NTFS file system, only cleanup messages are displayed.

/R 1 Locates bad sectors and recovers readable information.

1

[NTFS only] i Performs a less vigorous check of irdexes.

9/C [NTFS only] i Skips checking of cycles within the folder structure.

9 On a FAT or FAT32 file system, you may specify an individual file to check. To
do this, click Browse and choose the file from the Select File dialog box.

4. After you have selected a drive and parameters, click Add all marked disks

. The

chkdsk.exe command appears in the Command list along with the drive letter

and all parameters.

5. To add another drive, repeat steps 2 to 4.
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6. To remove a drive from the Command list, select it and click Delete command
> Delete Current

7. To remove all drives from the Command list, click Delete command > Delete
All.

8. To run all commands in the Command list, click Execute . A console session
appears.

9. Watch as the functions proceed.

After the command is complete, the console session closes.
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3.4.3 Display Settings

Helps to choose the resolution and number of colors displayed for the current display.

To use Display Settings configurator:

1. Inthe Active@ Boot Disk shell, click Start > System > Display Configurator
The List All Modes list appears with a list of all valid modes.

W List All Modes

—List of valid modes

X

&40 by 430, 256 Colors, Default Refresh

800 by 600, 256 Colors, Default Refresh

1024 by 768, 256 Colors, Default Refresh

1280 by 1024, 256 Colors, Default Refresh

&40 by 430, High Calor (16 bit), Default Refresh
800 by 600, High Color {16 bit), Default Refresh
1024 by 763, High Color (16 bit), Default Refresh
1280 by 1024, High Color (16 bit), Default Refresh
1152 by 564, 256 Colors, Default Refresh

1152 by 864, High Color (16 bit), Default Refresh
1152 by 564, True Color (32 bit), Default Refresh
1280 by 960, 256 Colors, Default Refresh

1250 by 960, High Color (16 bit), Default Refresh

=l

Apply |

Cancel |

2. Click a mode to select it. The Apply button is enabled.
3. Click Apply . The Monitor Settings  will appear.

The display mode is changed.
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3.4.5 Task Manager

Use Task Manager to troubleshootissues start programs, end processes, and to monitor

computer's performance.

Windows Task Manager
File Options View Help

Applications | Processes | Services Performance Metwaorking

CPU Usage

Memory

Physical Memory (MEB)

Total
Cached
Available
Free

Kernel Memary (ME)

Paged
Monpaged

Processes: 25

To open Task Manager, click Start > System > Task Manager. You may also use the
familiar key combination i Ctrl+Alt+Del

The Applications tab displays the status of the programs that are running on the

computer.

The Processes tab displays information about the processes that are running on the
computer. A process can be an application that you start or subsystems and services

CPU Usage History

Physical Memory Usage History

System

Handles 4954
Threads 180
Processes 25
Up Time 0:02:10:27
Commit (ME) 565 f 1235

Resource Monitar...

Physical Memory: 43%

that are managed by the operating system.

Similarly, the Services tab displays information about the services that are running on

the computer.

Click the Performance tab to view a dynamic overview of the performance of your
computer, you can monitor, for example memory available for th e current tasks.

RSN EOR &

to open Task Manager.
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3.4.6 Set Date, Time & Zone

When you set display configuration options for date and time in the operating system,
these settings affect the Date dialog box and other operating system windows. The Date
& Time changer also adopts the settings as you enter dates and times.

To open the Date & Time changer, click Start > System > Date , Time & Zone.

If you create records that are date and time dependent, they are stored in the current
time zone. If you change the time zone setting , records in the database are not changed
to reflect the new time zone setting. You must go back and manually change each
record to agree with the new time zone setting.

To set the date and time:
1. Click the Date & Time tab.
Use the calendar to pick the current date.
In the digital time box, click the hour, minute or second.

Use the spinner control to change the digit forward or backward.

a > DN

Click Apply .

To set the time zone:
1. Click the Time Zone tab.

[® pate and Time Properties ]|
Date & Time Time Zone I

I{GMT—DS:[JD}I Eastern Time (US & Canada) j

Ok | Cancel Apply |

2. From the drop-down list, set your time zone, relative to GMT (Greenwich Mean
Time).

3. Click Apply .
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3.3. 7 Search & Edit Local Registry Utility

This utility searches for registry hives in the local drives, and attaches them to the
Registry Editor for viewing or editing.

To describe what this utility can help you do, this section will describe the steps required
to recover from the Windows registry hive corruption in a case where the file table is still
intact.

To recognize the situations when you have a Windows registry hive corruption, while
trying to start Windows 2000 or Windows XP, you might get a message similar to this:

Windows could not start because the following file is missing or corrupt:
\WINDOWS SYSTEM3RCONFIGSYSTEM

or
\WINDOWS SYSTEM32CONFIGSOFTWARE

When you boot with Active@ Boot Disk, Windows PE willmount the un -functional drive
and assign it a different drive letter in order for you to have exclusive access to it.

To repair the broken registry hive, do the following:

1. From the Active@ Boot Disk shell, clickStart > Utilities > Search & Edit Local
Registry.

2. The Attach and Edit Local Registrydialog box appears.

{8 attach and edit local Registry x|

+ Perform search for Registry sets located on local disks

E[; ' T__ﬁ-‘-_.__“"“ where Results Q"
s -

; l & D\ (ACTIVEBOOT...

0 / \ e =g i\ (Boot)

¢ =3\

(.

2 Q

: \-)

NN Y

. Search |
i Searching:

—_

- ..~</ " Direct location: I _I

w Attach as: (HKLMY) IM\; external branch

3. To search local drives, do the following:

—

Attach & Edit Registry Hive |

1 Click the Perform search for Registry sets located on local disks radio
button.

1 Choosethe local drive folder that was mentioned in the error message.

1 Click Search . Drive and folder names will appear below the search button as
they are being searched.

1 Results of the search appear in the Results list.
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9 Select the broken hive in the Results list. The Attach as box is enabled.
1 Continue with step 4 below.
To browse directly to the broken hive, do the following:

9 Click the Direct location radio button. Controls in the lower area are
enabled.

fClick the ellipsis button (é) and browse to

Inthe Attach as box, type a custom hive name. This is a temporary name, so the
actual name does not matter.

Click Attach & Edit Registry Hive . The Registry Editor appears with the
custom hive selected.

" Registry Editor 10| =|
File Edit WView Favorites Help
(=-78 Computer Mame Type | Data

- [ HKEY_CLASSES_ROCT ab| (Default) REG_SZ {value not set)

- || HKEY_CURRENT_LISER
=~ | HKEY_LOCAL_MACHINE
- || HARDWARE
SRRy external branch
- Console

- |, Control Panel
- | Enwvironment
[+ |, Keyboard Layout
- L) Metwork

- . Software

B~ . System

© . 5AM

- ) SECURITY

- SOFTWARE

| SYSTEM

(- | HEEY_USERS

- | HEEY_CURRENT _CONFIG

ey 0 o IO P

| | i
|Cnm|:luter\.l-|KE‘r_LDCAL_MACHINE\|I'~1y external branch a4

If you are repairing a broken hive, Registry Editor will display a message that
s a yQGne dr more files containing the registry were corrupt and had to be
recovered by use of log files. The recovery was successfuld

In Registry Editor , select the temporary hive that you just created. From the File
menu, choose Unload Hive.

Dialogue box asking for your confirmation will appear. Click Yes. The temporary
hive is unloaded.
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3.3. 8 Add Language & Keyboard Layout

The default language for Active@ Boot Disk is English. You can add an alternate
language keyboard functional layout in order to give a file a descriptive name or when
recording notes about changes made to the system.

A typical English keyboard layout (called QWERTY) may be suitable for many Latin
based languages. With the French keyboard layout (AZERTY) the key associations
produce a different result on the screen.

You must be familiar with the different key associations to use a different language
keyboard layout.

To add a keyboard layout:

1 From the Active@ Boot Disk shell, clickStart > Utilities > Add Keyboard Layout
The Add Keyboard Layout dialog box appears.
x|

—Default Language
EE English

—Additional Language
(" L= Danish
" 4= Finland
" 11 French
™ German
11 1talian
@ Japanese
™ ‘% Korean
= Netherlands
. Portugese
" = Russian
~ 2 Spanish
¢ [ standart Cantonese
[ standart Mandarin
" 1= Swedish
" B Taiwanese

—MNotice
To change the keyboard layout press Alt+Shift

Set | Cancel |

1 Choose the radio button for the alternate keyboard layout that you want to use.

T Click Set. A short form for the current keyboard layout will appear in the system tray

area.

The alternate keyboard layout has been set.

To toggle between the default keyboard layout and the alternate keyboard layout, press

Left ALT+SHIFT on the keyboard.
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3.3.9 Bootab le Configuration (BCD) Editor

Active@ BCD Editor is a Windowsbased utility that allows you to edit entries in BCD
(Boot Configuration Data) store to make a Windows system partition bootable

Boot Configuration Data (BCD) is a database for boot-time configuration data. It is used
by Microsoft's Windows Boot Manager and replaces the boot.ini that was used by
NTLDR. It carries a set of entries describing booting options and location of Windows
Boot Loader, Windows Resume application and other important programs. BCD was
introduced along with Windows Vista and it is a replacement of older boot.ini format.
BCD store is used by Windows Vista, Windows 7, Windows 8, Windows Server 2008,
Windows Server 2012 and Windows 10.

W Active@ BCD Editor 1.0 64-bit = =R

File Help

e P :

% Refresh "---|_ﬂ? Open BCD h_:‘
Total BCD stores found: 1

Current BCD store device: Disk 0, Partition 1 [System Reserved (C:), NTFS, 100.0 MB]
Current BCD store path:  C:\Boot

Name Value 6

4 Windows Resume Application

Identification {5f8b0b16-edfd-11ed-bbdc-94abc63997a7}
Description Windows Resurme Application
Application path \Windows\system32\winresume.exe
Application device Partition 2 [Local Disk (D:), NTFS, 59.% GE]
05 device Partition 2 [Local Disk (D:), NTFS, 59.% GE]

4 Windows Boot Loader

Identification {5f8b0b17-edf4-11ed-bbdc-94abc63997a7}
Description Windows 7

Application path \Windows\system32\winload.exe
Application device Partition 2 [Local Disk (D:), NTFS, 59.% GE]
05 device Partition 2 [Local Disk (D:), NTFS, 59.% GE]

4 Windows Boot Manager
Identifier {9deaBb2c-5cdd-4e70-acc1-F32b344d4795}

Description Windows Boot Manager

N Flmbihi o A [k T aled aTee 4 paml

Ready

After the launch Active@ BCD Editor scars all disks in the system and looks for BCD
stores which could be more than one if there are disks presented containing boot
configuration from another machine. The first BCD store is open and available to edit.
Before making changes make sure that you use a correct BCD store. Use Open BCD
command to change the current BCD store. The main screen contains a list of all BCD
store entries and their parameters. Out of those parameters only Application device
and OS device are intended to be changed, all other data is shown for information
only. The main task of BCD Editor is to assign a correct device for each application in
BCD store, so Windows would be booted correctly.

For more information, read Active@ BCD Editor documentation.
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3.5 Internet

The Active@ Boot DiskInternet utilities include:

1 Internet Browser 1 Fast, customizable, portable and lightweight web browser
for the Windows platform.

1 Mail Sender i Send an email message with attachments quickly and easily.
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3.5.1 Internet Browser

You may access information from the Internet quickly and easily using Portable Internet
Browser.

7 LSoft Technologies Inc. creates Data Security, Backup, Recovery Solutions - Opera o [ 55

E Opera || (@)L soft Technologies Inc. c... % | o2

& 5 D o= | @web | wowlsoftnet {t“v Search with Google

B
LSofi':@jTechnologies |

+ @ C 9 %

Home

Disk Utilities Data Recovery Software

Accidentally deleted some files or ewen a partition? Has yo
Data Recovery been lost due to aformatted drive? You will be able to retrie
pictures, music, movies and document files even if your driv
disappeared from the computer and need to get back all th
Data Security residad there. There are several solutions to recowver that we
important data of yours: Active @ File Recovery. Active

UNDELETE, Active(@ Partition Recovery

Data Backup

Data Utility Tools Data Recovery Tools Data Security Tools Data Backuj
Active@ Data 5tudio Active@ File Recovery Active@ KillDisk Active@ Disk Image
Complete IT Technician's package Powerful Data Recovery Software Hard Digk, HOD/USB Disk Eraser Hard Drive Image & Eici;l
Cil | »
O & o P

Here are some featuresin Internet Browser:

1 When you start a new browser session, you may choose to restore the settings
and tabs from the last session This option is useful if you accidentally closed the
browser.

1 Turn on Private Browsing mode and you will not leave any traces of your activities
on your computer. When you visit a web page, a text string is sent to identify
such things as the application name, version, host operating system, and
language. With Private Browsing, even this text string is masked.

9 Supports SSL(Secure Sockets Layer)for secure communications on Internet web
sites.
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3.5.2 Mail Sender

Use a simple Mail Sender to send an email message to ask for support or to make any
other kind of contact.

To use Mail Sender:

1. From the Active@ Boot Disk shell, clickStart > Internet > Mail Sender

MailSender dialog box will appear.

—Message

=[]

From:

—Settings
SMTF Server Name or IP

To:

Subject:

Attachment:

SMTF Server Port

| 25 3:
[~ Authentification

Usermame

—

Password

E—

w Get SMTP subscription |

a > DN

To add an attachment, click the Attachment

you want to attach.

6. To use your existing email service provider, in Settings , do the following:

In From , type the email address that the recipient can reply to.

. The

In To, type the destination email address where you want the message sent.
In Subject , type the subject of the email.

button and navigate to the file that

1 In Server Name , type the outgoing mail server (SMTP) address in the

f or mat

fiserver name.

host name.

extensi

will accept the email message from the application and forward it to
the destination email address.

7 In Port, select a port number using the scroll field. (Usually 25.)

1 If your email server requires authentication, select the

Authentication

7. ClickSend.

A
el NOtE:

You cannot receive emails with this simple Mail Sender client.

check box and provide the user name and password.
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3.6 Console Tools

The Active@ Boot Diskconsole utilities include;

1 Command Prompt T Run command prompt utility (cmd.exe) to create and run
batch files or perform other DOS commands.

1 View Network Status - ipconfig (IP Configuration) in Windows is a utility to
print the local computer's current network configuration.

9 Partition Manager (DiskPart.exe) 1 Command line tool to create, delete,
format and resize basic partitions and logical partitions, and manage dynamic
volumes.

1 RAID Manager (DiskRAID .exe) i Command line tool to create, delete, format
and resize basic partitions and logical partitions, and manage dynamic RAIDs.

9 FTP Client 7 A console utility to help you download or upload fi les from an FTP
site.
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3.6.1 Command Prompt

To open the DOSlike command line interpreter, click Start > System > Command
Prompt (Cmd.exe).

B Administrator, XA\Windows\System32\cmd.exe E@
Microzoft Windows [Uersion 6.3.76H81 -

Wi~ Program Files“BOOTDISK>

In this environment, you may run character -based applications and utilities. You can use
command prompt to create and edit batch files to automate routine tasks. This can
make you more efficient than if you were doing these tasks using Boot Disk Explorer.

For more information about command line console commands, see
http://technet.microsoft.com/en -cal/library/bb491071.aspx.
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3.6.2 View Network Status

This utility works only on computers with network adapters.

The ipconfig utility displays current TCP/IP network configuration values, updates, or
releases, DHCP (Dynamic Host Configuration Protocol) allocated leases, and display,

register, or flush DNS (Domain Name System) names.

o K\ windows\SYSTEM32\cmd.exe
Ethernet adapter EthernetB:

Connection—specific DNS Suffix H
Description : Inteld(R> 82574L Gigabit Metwork Connec

Physical Addre : B9-BC-29-BA-32-36
DHCP Enabled : Yes
Autoconf iguration Enabled : Yes

o[- ]

Link-local IPve Address : FeB@::50ad:376:1982:c53dx3(Preferred?

IPv4 Address : 172.168.1.61 (Preferredl

Subnet Mask = 255.255.255.8

Leasze Obtained : Saturday,. March 15, 1879 7:82:35 AM
Lease Expires : Wednesday,. April 22, 2815 168:38:52 AM

Default Gateway = 192.168.1.1
DHCP Server = 192.168.1.1
DHCPve IAID = 5@334761

DHCPv6 Client DUID : B9-P1-88-81-1C-C3—4F-B2-88-8C-29-BR-32

DNE Servers : 192.168.1.1
NetBIOS over Tcpip : Enabled
Press any key to continue . . .

To view the status of the local area connection:

1. From the Active@ Boot Disk shell, clickStart > Network >
Status .

View Network

2. The View Network Status  console session appearsshowing Windows IP

Configuration.

3. To close the console session, pess any key on the keyboard.
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3.6.3 DiskPart Partition Manager

DiskPart is a text-mode command interpreter. This tool enables you to manage objects
(disks, partitions, or volumes) by using scripts or direct input at a command prompt.

K KA\Windows\System32\diskpart.exe E\@

Microsoft DiskPart version b.3.9608

Copyright (C> 1999-20813 Microsoft Corporation.
On computer: MININTI-?P2Q76A

DISKPART > list wolumes
Microsoft DiskPart version 6.3.9608
— Display a list of disks. For example, LIST DISK.

— Display a list of partitions on the selected disk.
For example, LIST PARTITION.

— Display a list of volumes. For example, LIST UOLUME.
— Displays a list of virtwal disks.

DISKPART > list wolume

Uolume ##f Lty Label

Uo lume F DUD_ROM DUD—ROM Healthy
Uo lume H Partition Healthy
Uo lume D Partition Healthy
Uo lume E Partition Healthy

DISKPART >

Diskpart enables a superset of the actions that are supported by the Disk Management
Control Panel snapin. The Disk Management snap-in prohibits you from inadvertently
performing actions that may result in data loss. It is recommended that you use the
Diskpart utility cautiously because Diskpart enables explicit control of partitions and
volumes.

You can use Diskpart to convert a basic disk to a dynamic disk and backward. The basic
disk can either be empty or contain either primary partitions or logical drives. The basic
disk can be a data disk or system or boot drive.

You can use Diskpart to create a partition at an explicit disk offset. The Disk
Management snap-in places the partition at the end of any occupied area or on the first
sufficiently large area. On master boot record (MBR) disks, the patrtition offset and the
size are rounded to preserve the required cylinder alignment. Offsets are rounded to the
closest valid value, and the size is always rounded up to the next valid value. Diskpart
does not assign a drive letter to a newly created partition. Use the assign command to
assign either a mount point or a drive letter.

Diskpart permits certain partition deletion operations that are blocked by the snap -in.
For example, you can use Diskpart to delete MBR OEM partitions. However, these
partitions often contain files that are important to the platform operation. Diskpart
blocks the deletion of the current system, boot, or paging volumes and partitions. Also,
Diskpart blocks deletion of the partitions that underlie dynamic disks.

Diskpart causes disk signatures, GUID partition table (GPT) disk globally unique
identifiers (GUIDs), and GPT patrtition GUIDs to be generated.

The Diskpart utility includes support for the new disk partition scheme called GPT. You
cannot use GPT disks on any x86based Windows XRbased or Windows 2000-based
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computers. Diskpart enables the conversion of GPT partitioningto MBR partitioning only
for empty disks.

You can use Diskpart to delete missing dynamic disks. Dynamic disks contain a shared
database; all of the dynamic disks on a computer have knowledge of all other dynamic
disks on that computer. When dynamic disks are moved, the original computer considers
these disks as "missing".

Drive letters are not automatically assigned when you use Diskpart. To ensure that a
given partition or volume has a drive letter, you must explicitly assign a drive letter. You
can either assign the drive letter or allow the next available drive letter to be allocated.

DiskPart Commands

Before you can use DiskPart commands on a disk, partition, or volume, you must first
list and then select an object to give it focus. When an object has focus, any DiskPart
command that you input will affect that particular object.

You can list the available objects and determine an object's number or drive letter by
using the list disk, list volume, and list partition commands. The list disk and list volume
commands display all disks and volumes inthe computer. However, the list partition
command displays only partitions on the disk that have focus. When you use the list
commands, an asterisk (*) appears next to the object with focus. You select an ob ject
by its number or drive letter, such as disk 0, partition 1, volume 3, or volume C.

When you select an object, the focus remains on that object until you select a different
object. For example, if the focus is set on disk 0, and you select volume 8 as on disk 2,
the focus shifts from disk O to disk 2, volume 8. Some commands automatically change
the focus. For example, when you create a new patrtition, the focus automatically
changes to the new partition.

You can give focus only to a partition on the sel ected disk. When a partition has focus,
the related volume (if any) will also have focus. When a volume has focus, the related
disk and partition also have focus if the volume maps to a single specific partition. If this
is not the case, then focus on the disk and patrtition is lost.

Run:
> DiskPart.exe ?

To see all DiskPart commands and syntax.

DiskPart Scripting

By using the DiskPart CommandLine Options command-line tool, you can create scripts
to automate disk-related tasks, such as creating volumes or converting disks to dynamic
disks. Scripting these tasks is useful if you deploy Windows by using unattended Setup
or the Sysprep tool, which do not support creating volumes other than the boot volume.

To start a DiskPart script, at the command prompt, typ e:
>Disk Part .exe /s scriptname xt

€ where scriptname is the name of the text file that contains your script.
Read more detailed information on DiskPart usage:
https://tec hnet.microsoft.com/en -us/library/cc766465(v=ws.10).aspx
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3.6.4 DiskRAID Manager

DiskRAID is a command-line tool that enables you to configure and manage redundant
array of independent (or inexpensive) disks (RAID) storage subsystems.

RAID is a method used to standardize and categorize fault-tolerant disk systems. RAID
levels provide various mixes of performance, reliability, and cost. RAID is usually used
on servers. Some servers provide three of the RAID levels: Level O (striping), Level 1
(mirroring), and Level 5 (striping with parity).

A hardware RAID subsystem distinguishes physically addressable storage units from one
another by using a Logical Unit Number (LUN). A LUN object must have at least one
plex, and can have any number of additional plexes. Each plex contains a copy of the
data on the LUN object. Plexes can be added to and removed from a LUN object.

Most DiskRAID commands operate on a specific host bus adapter (HBA) port, initiator
adapter, initiator portal, provider, subsystem, controller, port , drive, LUN, target portal,
target, or target portal group. You use the SELECT command to select an object. The
selected object is said to have focus. Focus simplifies common configuration tasks, such
as creating multiple LUNs within the same subsystem.

Example:

To select subsystem 0, type the following at the DiskRAID prompt:
DISKRAID> select subsystem 0

Press ENTER. Output similar to the following is displayed:

Subsystem 0 is now the selected subsystem.
To list all drives in the system, type:

DISKRAID> list drives

Drive ### Status  Health Size  Free Bus Slot Flags

Drive 0 Online  Healthy 107GB 107GB 0 1
Drive 1 Offline  Healthy 29GB 29GB 1 0
Drive 2 Online  Healthy 107GB 107GB 0 2
Drive 3 Not Ready Healthy 19GB 19GB 1 1

Read more detailed information on DiskRAID usage:
https://technet.microsoft.com/en -us/library/cc770763.aspx
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3.6.5 FTP Client

Use Microsoft FTP Client (console) to transfer files to and from your computer running
an FTP (File TransferProtocol) server service such as Internet Information Services. FTP
can be used interactively or in batch mode by processing ASCII text files.

1 To launch FTP Client fom the Active@ Boot Disk shell, click Start > Internet
> FTP Client.

Type:
> ftp /?
To see the list of commands available and the syntax.

Examples:

To anonymously log on to the FTP server named ftp.example.microsoft.com, type the
following command:

ftp -A ftp.example.microsoft.com

To log on to the FTP server named ftp.example.microsoft.com and run the ftp
commands contained in a file named Resynch.ixt, type the following command:

ftp -s:resynch.txt ftp.example.microsoft.com

Read more detailed information on FTP client usage:

http://www.microsoft.com/resources/documentation/windows/xp/all/proddocs/en _ -
us/ftp.mspx?mfr=true
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3.7 Professional Tools

The Active@ Boot DiskProfessional tools included in the Professional (commecial)
package

1 Windows PowerShell - is a task automation and configuration management
framework from Microsoft, consisting of a command-line shell and associated
scripting language built on the .NET Framework. PowerShell provides full access
to COM and WMI, enabling administrators to perform administrative tasks on both
local and remote Windows systems as well as WSManagement and CIM enabling
management of remote Linux systems and network devices.

1 BitLocker Manager - tool can be used to turn on or turn off BitLocker, specify
unlock mechanisms, update recovery methods, and unlock BitLockerprotected
data drives.

1 BitLocker Repair T toolis used to recover access to BitLockerprotected drives
that have been damaged or corrupted when access cannot be restored by using
the recovery console.

9 iSCSI Manager - is a command-line tool for managing iISCSI device connections
and security.

1 WMI Console - command-line interface to WMI called Windows Management
Instrumentation Command-line (WMIC).

1 SSH Client - Secure ShellClient Library allows to connect to and control remote
computers via secure channel using simple scripting language

9 Telnet Client 1 A console utility to help you access remote sites in a terminal
session.
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3.7.1 Windows PowerShell

Windows PowerShell is a task automation and configuration management framework
from Microsoft, consisting of a command-line shell and associated scripting language
built on the .NET Framework. PowerShell provides full access to COM and WMI, enabling
administrators to perform adm inistrative tasks on both local and remote Windows
systems as well as WSManagement and CIM enabling management of remote Linux
systems and network devices.

3 C:ne Get—Childlitem *HediaCenter:“Music’ —rec | )
> where { -not $_.PElsContainer —and %_.Extension —-match "wnaimp3’®
Meazure—0bject —-property length —sum -min —-max —-ave

: 1387
: 5491276 .89563887
: 717IBI7BS7
: 22985267
: 3235
Property : Length

P8 C:ny Get=WmiObject CIM_BIOSElement | select biosuw=, man®, sere | Format-List

BlOSVersion : {TOSCPL 6848088, Ver 1.B88PARTTEL>
Hanufacturer : TOSHIBA
SerialMunber : MB21116H

S C:n> Shost.version.ToString{).Insert{B, ‘Windows PowerShell: *)
lindows FowerShell: 1.8.8.8

g C=vD

In PowerShell, administrative tasks are generally performed by cmdlets , which are
specialized NET classes implementing a particular operation. Sets of cmdlets may be
combined into scripts, executables (which are standalone applications), or by
instantiating regular .NET classes (or WMI/COM Obijects). These work by accessing data
in different data st ores, like the file system or registry, which are made available to the
PowerShell runtime via Windows PowerShell providers.

Windows PowerShell also provides a hosting API with which the Windows PowerShell
runtime can be embedded inside other applications. These applications can then use
Windows PowerShell functionality to implement certain operations, including those
exposed via the graphical interface. Different Microsoft applications, for example
Microsoft SQL Server 2008 also expose their management inerface via PowerShell
cmdlets. With PowerShell, graphical interface-based management applications on
Windows are layered on top of Windows PowerShell.

Windows PowerShell includes its own extensive, consolebased help, similar to man
pages in Unix shells, via the Get-Help cmdlet.

Examples:

This example lists all services registered on the machine and prints their current status:
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Get-Service|Foreach  {$_.name + " Status: -" + $_.status}

This example finds all Windows Log Fileswith 'Error' inside:

ClearHost

$Directory = "C: \Windows\"

$Phrase = "Error"

$Files = Get-Childitem $Directory -recurse -Include *.log
-ErrorAction SilentlyContinue

$Files | Select-String $Phrase-ErrorAction SilentlyContinue °

| Group-Obiject filename | Sort-Object count T descending

Read more detailed information on PowerShell usage:
http://en.wikipedia.org/wiki/Windows PowerShell
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3.7.2 BitLocker Manager

BitLocker Manager - tool being used to turn on or turn of f BitLocker, specify unlock
mechanisms, update recovery methods, and unlock BitLockerprotected data drives. This
tool can be used in place of the BitLocker Drive Encryption Control Panel item.

BitLocker Drive Encryption (BitLocker) is a component of Windows Vista and later
versions of Windows that helps to protect data by encrypting the entire volume and
checking the integrity of early startup components.

Examples:

To unlock BitLocker-encrypted D: drive using the password:

manage-bde 1 unlock D: -rp < recovery password>

To unlock BitLockerencrypted D: drive using the recovery key stored in the file:
manage-bde i unlock D: -rk C:\<recovery-key-file name>

Read more detailed information on BitLocker command-line tool usage:
https://technet.microsoft.com/en -us/library/dd875513(v=ws.10).aspx
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3.7.3 BitLocker Repair

The BitLocker Repair Tool can be used to access encrypted data on a severely damaged
hard disk if the drive wa s encrypted by using BitLocker. Repairbde can reconstruct
critical parts of the drive and salvage recoverable data as long as a valid recovery
password or recovery key is used to decrypt the data. If the BitLocker metadata data on
the drive has become corrupt, you must be able to supply a backup key package in
addition to the recovery password or recovery key. With this key package and either the
recovery password or recovery key, you can decrypt portions of a BitLocker-protected
drive if the disk is corru pted. Each key package will work only for a drive that has the
corresponding drive identifier.

The Repair -bde command-line tool is intended for use when the operating system does
not start or when you cannot start the BitLocker Recovery Console. You should use
Repair-bde if the following conditions are true:

1. You have encrypted the drive by using BitLocker Drive Encryption.

2. Windows does not start, or you cannot start the BitLocker recovery
console.

3. You do not have a copy of the data that is contained on the encrypted
drive.

Example:

To recover damaged BitLocker volume othe and st or e
image file on volume D:

> repair -bde C:D: \imagefile.img

Read more detailed information on BitLocker repair command-line tool usage:
https://technet.microsoft.com/e n-us/library/ee706528(v=ws.10).aspx
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3.7.4 iISCSI Manager

iISCSI Manager (iscsicli.exe command allows you to use the Microsoft iISCSI initiator
without the GUI. Making it the perfect tool for scripting the iSCSI connections (Hyper -V
Server shared storage). If you know the ip -address of your iSCSI storage and the IQN of
the LUN you want to use (thoug h it can be found with the command), you are all set to
set up the connection and use your shared storage.

Examples:

To list all available iISCSI Targers:
iscsicli.exe ListTargers

To login to the particular target:
iscsicli.exe QloginTarget [target-ign]

Read more detailed information on iscsicli.exe command-line tool usage:
http://www.virtues.it/2010/04/howto -w2k8-iscsicli/
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3.7.5 WMI Console

WMI Console is a command-line interface to WMI called Windows Management
Instrumentation Command-line (WMIC).

In Microsoft computer systems, Windows Management Instrumentation (WMI) consists
of a set of extensions to the Windows Driver Model that provides an operating system
interface through which instrumented components provide information and notification.
WMI is Microsoft's implementation of the Web-Based Enterprise Management (WBEM)
and Common Information Model (CIM) standards from the Distributed Management
Task Force (DMTF).

WMI allows scripting languages (such as VBScript or Windows PowerShell) to manage
Microsoft Windows personal computers and servers, both locally and remotely.

Examples:

To list all processes

wmic > process list

To list all logical disks, their filesystem, name, size and description:

wmic > logicaldisk get filesystem, name, size, description

Read more detailed information on WMI & WMIC syntax:
http://en.wikipedia.org/wiki/Windows Managem ent_Instrumentation

https://technet.microsoft.com/en -us/library/cc779482(v=ws.10).aspx
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3.7.6 SSH Client

Secure Shell Client Library(SSH.NET) allows to connect to and control remote
computers via secure channel using simple scripting language

ey Administrator; X\Windows\System32\WindowsPowerShell,

Windows PowerShell i ) )
Copyright ({C) 2013 Microsoft Corporation. All rights reserved.

55H.NET library registered ) _ _
o start a mew S5H ion, type: MNew-5shSession [host] [user]

Read usage at sshnet.codeplex. com

(:%Program FilesBOOTDISK= Mew-5shSesszion =df alexbd
provided. Enter 55H p word for alexbd:
111y connected to

Features:

E I

= =4 -4 -4 -

Execution of SSH command using both synchronous and asynchronous methods
Return command execution exit status and other information

Provide SFTP functionality forboth synchronous and asynchronous operations.
Provides SCP functionality.

Provide status report for upload and download sftp operations to allow accurate
progress bar implementation

Remote, dynamic and local port forwarding
Shell/Terminal implementation.

Specify key file pass phrase

Use multiple key files to authenticate

Supports diffie-hellman-group-exchange-sha256, diffie-hellman-group-exchange-
shal, diffie-hellman-groupl4-shal and diffie-hellman-groupl-shal key exchange
methods.

Supports 3des-chc, aes128-cbc, aes192cbc, aes256-cbc, aes128-ctr, aes192-ctr,
aes256-ctr, blowfish-cbc, cast128-cbc, arcfour and twofish encryptions.

Supports hmac-md5, hmac-shal, hmac-ripemd160, hmac-sha2-256, hmac-sha2-
256-96, hmac-md5-96 and hmac-shal-96 hashing algorithms.

Supports publickey, password and keyboardinteractive authentication methods
Supports RSA and DSA private key

Supports DESEDE3CBC, DESEDE3CFB, DESCBC, AESL28-CBC, AES192-CBC
and AES256-CBC algorithms for private key encryption.

Supports two-factor or higher authentication
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1 Supports SOCKS4, SOCKS5 and HTTP Proxy

Examples:
To read help on registered with PowerShell functions, type:

> get-help *ssh*

PS E:%» get-help “ssh®

Hame Category  Synopsis

Get-5shiession Function Shows all, or the specified, 55H sessionz in the global $Sshiessions wvar. ..
Remowe-Sshhession Function FRemoves opened 553H connections. Use the parameter -RemowveAll to remove a. ..
New-5shSession Function Creates 55H sessions to remote 55H-compatible hosts, such as Linux. ..
Invoke-5shCommand Function Invoke/rum commands via 55H on target hosts to which you have already op...
Enter-5sh5ession Function Enter a primitive interactive 55H session against a target host....

To register a new SSH session to remote SSHcompatible host, type:

> New-SshSession[hostname] [username]

To invoke a SSH commandls on a target host having opened session, type:

> Invoke -SshCommand [hostname] i Command 'Is’

Read more detailed information on SSH.NET & usage with PowerShell
https://sshnet.codeplex.com/

http://www.powershelladmin.com/wiki/SSH_from_PowerShell _using _the SSH.NET library
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3.7.7 Telnet Client

With Telnet Client, Windows users can connect to a remote computer running a Telnet

server and run applications on the remote computer or perform administrative tasks on
it.

2 Administrator: X:\Windows\System32\WindowsPowerShell\v1.0\powershell.exe
To =tart a new Telnet seszion type: telnet [host] [port]
(:%Program Fi1 BOOTD » telnet smtp-serwver.com 25
Connecting to smtp- erver.com on port 2
Connected. Press AD and [ENTER] to exit

ver.com | ESMTP READY | WELCOME TO SMTP-SERV

-8BITMIME

Telnet uses the Telnet protocol (part of the TCP/IP protocol suite) to connect to a
remote computer over a network.

Type:

> telnet.exe /?

To see the list of commands available and the syntax.
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4 About Boot Priority

To boot from a CD, DVD or USB device, make sure that the device has the boot
sequence priority over the hard drive.

4.1 BIOS Boot

BIOS (Basic Input Output Subsystem) is a programmable chip that controls how
information is passed to various devices in the computer system. A typical method to
access the BIOS settings screen is to press ESC, F1, F2, F8 or F10 durgnthe boot
sequence.

BIOS settings allow you to run a boot sequence from a removable disk, a hard drive, a
CD-ROM drive or an external device. You may configure the order that your computer
searches these physical devices for the boot sequence. The firstdevice in the order list
has the first boot priority. For example, to boot from a CD -ROM drive instead of a hard
drive, place the CD-ROM drive ahead of the hard drive in priority.

+Renovable Devices

Before you set boot priority for a USB device, plug the device into a USB port.
To specify the boot sequence:

1. Start the computer and press ESC,F1, F2, F8 or F10during the initial startup
screen. Depending on the BIOS manufacturer, a menu may appear.

2. Choose to enter BIOS setup. The BIOS setup utility page appears.
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3. Use the arrow keys to select the BOOT tab. System devices appear in order of
priority.

4. To give a CD or DVD drive boot sequence priority over the hard drive, move it to
the first position in the list.

5. To give a USB device boot sequence priority over the hard drive, do the following:
1 Move the hard drive device to the top of the boot sequence list.
9 Expand the hard drive device to display all hard drives.
1 Move the USB device to the top of the list of hard drives.

6. Save and exit the BIOS setup utility.

The computer will restart with the changed settings.

Some computer manufacturers allow you to select the device that contains the boot
sequence from a special device selection menu. The example below uses a Dell system
board.

To set boot priority using a device selection menu:

1. When the computer starts to boot up, after the manufacturer's ID screen, press
F12 several times. The device selection menu appears.

Use the up and down arrows to select CD-ROM or an USB Flash Drive .
3. To boot from the selected device, press ENTER.

£

JNote Using an incorrect BIOS setting can cause a system malfunction. Please
follow the BIOS guide provided with your computer motherboard. If you
read these instructions and you are not sure how to change a setting, it is
better to leave it as the defa ult setting.

Active@ Boot Disk is able to boot both legacy BIOS or UEFI secure boot systems.

However, if for some reason, BIOS mode does not boot the machine (computer hangs
up, crashes, etc...), try UEFI secure boot mode.
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4.2 UEFI Secure Boot

Some modern computers use new advanced UEFI secure boot approach instead of the
standard BIOS boot . In case if your machine does not boot after you set up boot
priority as it is described above, you should check whether BIOS boot is enabled
(Legacy mode), or UEFI mode .

Here is how you can check your BIOS settings.

At the moment of turning on your computer, you will see an option to enter SETUP.
Depending on the manufacturer of your system, you can press the DEL key, the F2 key
or another key that is listed on screen to access the system BIOS. If you are not sure,
consult the User Guide that came with your computer or call the manufacturer's
technical support for assistance.

Once in your system BIOS, look under the Boot menu to find an option that reads
"UEFI/BIOS Boot Mode" or "UEFI Boot". In the case of "UEFI/BIOS Boot Mode" switch
the mode from "UEFI" to "Legacy" mode, or backward.

Active@ Boot Disk is able to boot both legacy BIOS or UEFI secure boot systems.

However, if for some reason, UEFI mode does not boot the machine (computer hangs
up, crashes, etcé), try |l egacy BI OS boot mode.
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5. Frequently Asked Questions

5.1 How to load Active@ Boot Disk over the network via PXE
environment?

There are several steps required, configuring WinPE WIM, Boot Manager and PXE Server

For the configuration steps, let's assume that inserted Active@ Boot Disk has a D: letter in
our configuration environment.

Step 1: Copy WInPE Source Files onto PXE Server

1 Map a network connection to the root TFTP directoryonthe PXE/ TFTP server (letds a
it has a F: letter) and create there a \Boot folder (full name F:\Boot)
1 Copy the bootable Windows PE image(D: \ SOURCES\ BOOT.WIM) to the F:\ Boot folder
(on PXE/TFTP server)
1 Copy the BOOT.SDI file from D:\ BOOT folder of inserted Active@ Boot Disk to the
F:\ Boot folder (on PXE/TFTP server)
1 Copy the BCD file from D:\ BOOT folder of inserted Active@ Boot Disk to the F:\ Boot
folder (on PXE/TFTP server)

Step 2: Configure custom boot configuration (optional)

In case if default boot configuration supplied with Active@ Boot Disk (stored in file BCD) does
not work for you, you can configure your custom boot configuration:

f On a WindowsE 7 computer or in a Windows PE enviro
the BCDEdit tool

I Create the RAMDISK setting, BOOTMGR and OSLoader settings for the Windows PE image

1 Copy the BCD file to the F:\ Boot folder (on PXE/TFTP server)

Step 3: Deployment process

1 Configure your PXE/TFTPserver to point PXE clients to download Wdsnbp.com

1 Aclientis directed (by using DHCP Options or the PXE Server response) to
download Wdsnbp.com

I Wdsnbp.com validates the DHCP/PXE response packet and proceeds to download
PXEBoot.com

1 PXEBoot.com downloads Bootmgr.exe and the BCD store. The BCD store must reside in
a \Boot directory in the TFTP root folder. Additionally, the BCD store must be called BCD
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1 Bootmgr.exe reads the BCD operating system entries and downloadsBoot.sdi and the
Windows PE image

I Bootmgr.exe begins booting Windows PE by running Winload.exe within the Windows
PE image

5.2 Customizing WIM

We are using a WIinPE environment that is booted into via PXE from a Windows Deployment
Server. | am wondering if there is a way for us to copy registry information and files into the
WIM file that we boot from so t he applications are already installed and registered? Or will |
need to script the installation and registration to occur each time we boot into WinPE?

Customizing WIM is a complex task, however it can be done. To accomplish this, run the
following:

1. Mount WIM:

Dism /Mount - Wim /WimFile:D:  \ sources \ boot.wim /index:1 /MountDir:D: \!

2. Attach Registry from a file to your local registry, add your values, unload registry:

reg load HKLM \ my D: \ I'\ windows \ system32 \ config \ software

reg add "HKLM \ my\ Microsoft \ Windows NT \ CurrentVersion \ Fonts" /v "Courier New
(TrueType)" /t REG_SZ /d cour.ttf

reg unload HKLM \ my

3. Unmount WIM:

Dism /unmount - Wim /MountDir:d: \ I /Commit

This requires Microsoft's Windows AIK and done from a command prompt
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5.3 Disks not visible under Boot Disk environment

The Active@ Boot Disk cannot see the drives in my system, what can | do so they
would be detected?

Suggestions: The set of common drivers in Active@ Boot Disk  may not include the driver for
your hard drive controller.

In this case, you can add or load additional drivers yourself...

Firstly, you will need to identify the type of hard drive controller you have in your computer.
You can look that up in the properties of My Computer & Device Manager o under| DE
ATA controllers  or under Storage controllers

Another way is to look up the specifications of your computer from the manufacturer's web
page.

Whether you have a Dell, HP, Sony, Gateway or other brand of system, the manufacturer's
support pages will identify what controller you have based on your system's model number or
other service identifying number.

The manufacturer's support pages are also the location of where you can download the drivers
for your system. You will need to download the 64 bit drivers (x64 architecture) as the
Active@ Boot Disk environment is based on a64 bit version of Windows. Once you have
downloaded the drivers, you can load them in one of three ways.

1 When running the Boot Disk Creator add the driver INF and accompanying SYS files to
the "Add Drivers" section. These will be saved to the bootable media and automatically
loaded when booting your system up.

I Youcan load the drivers after boot -up. Once booted into Active@ Boot Disk, Click on the
Start menu , then select "Load Driver" . The dialog allows you to browse to the
location of where you stored the driver INF and accompanying SYS files. Clicking on the
INF file will load the drivers.

I Create a folder called BootDisk_Drivers on the root of any drive that will b e visible after
boot (without requiring the extra drivers) and copy the required files to that folder.

During the boot process, these drivers will be loaded automatically.

You should be able now to access your hard drives after the driver is successfully loaded.

Tip: You can remove the Boot Disk Media at any time after boot -up and insert the media
where you have stored your driver files to be loaded.
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Glossary

BIOS settings

Basic Input Output Subsystem. Programmable chip that controls how information is
passed to various devices in the computer system. A typical method to access the BIOS
settings screen is to press ESC, F1, F2, F8 or F10 during the boot sequence.

boot prior ity

First device, or any device that is higher in the order list having preference over devices
that are lower in the order. BIOS settings allow you to run a boot sequence from a
floppy drive, a hard drive, a CD-ROM driveor a flasd drive. You can configure the order
in which your computer searches these physical devices for the boot sequence. For
example, to boot from a CD-ROM drive instead of a hard drive, place the CD-ROM drive
ahead of the hard drive in priority.

boot record
See MBR.

compressed clu ster

Data that uses less disk space. When you set a file or folder property to compress data,
the file or folder uses less disk space. While the size of the file is smaller, it must use a
whole cluster in order to exist on the hard drive. As a result, com pressed clusters
contain "file slack space". This space can contain residual confidential data from the file
that previously occupied this space. KillDisk can wipe out the residual data without
touching the existing data.

cluster

Logical group of disk sectors, managed by the operating system, for storing files. Each
cluster is being assigned with a uniqgue number when being used. The operating system
keeps track of clusters in the hard disk's root records or MFT records. (See lost cluster)

exclusive acc ess

Lock that is applied to a partition for exclusive writing access, for example while
recovering deleted or damaged files or folders. The recovery operation must have
exclusive access to the target partition while recovering files. If another applicatio n or
the operating system is using the target partition, you must close all applications or
system processes that may be using the target partition before locking it.

FAT

File Allocation Table. File that contains the records of every other file and directory in a
FAT-formatted hard disk drive. The operating system needs this information to access
the files. There are FAT32, FAT16 and FAT versions.
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free cluster
A cluster that is not occupied by a file data. This space may contain residual confidential
data from the file that previously occupied this space.

file slack space

Unused portion of a cluster. The smallest file (and even an empty folder) takes up an
entire cluster. A 10-byte file will take up 2,0 48 bytes if that is the cluster size. This space
could contain residual confidential data from the file that previously occupied this space.

deleted boot records
Damaged or erased MBR. In a damaged disk, if the location of the boot records is
known, the partition table can be reconstructed.

hive
Highest level of organization in the Windows registry. At this level, system and local
variables are stored.

ISO

Informal term for a disk image in the ISO 9660 file standard format. ISO 9660 file
system is a standard, published by the International Organization for Standardization. It
defines a file system for CD-ROM or DVDROM media that allows you to read the same
CD or DVD whether you're on a PC, Mac, or other major computer platform. Making a
disk image in the 1SO 9660 file standard (an ISO image) is a common way to
electronically store and transfer the contents of a hard drive. An ISO image often has
the filename extension .ISO (although not necessarily), and is commonly referred to as
an "ISO".

lost cl uster

Cluster with an assigned number in the file allocation table, even though it is not
assigned to any file. You can free up disk space by reassigning lost clusters. In DOS and
Windows, you can find lost clusters with the ScanDisk utility.

MBR

Master Boot Record. All disks start with a boot sector. When you start the computer, the
code in the MBR executes before the operating system is started. The location of the
MBR is always track (cylinder) 0, side (head) O, and sector 1. The MBR contains a file
system identifier.

MFT records

Master File Table. File that contains the records of every other file and directory in an
NTFSformatted hard disk drive. The operating system needs this information to access
the files.
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root records
See FAT.

PXE Boot

Preboot Execution Environment (PXE) - set of standards that enables a computer to load
an operating system (OS) over a network connection.

SAM

Security Account Manager. Database stored as a registry file in Windows. It stores users'
passwords in a hashed format. Since a hash function is one-way, this provides some
measure of security for the storage of the passwords.

sector
Smallest unit that can be accessed on a disk. Sectors are segments within each track.

track
Circle of data around a disk. Tracks form concentric circles on a disk.

unallocated space
Space on a hard disk where no partition exists. A partition could have been deleted or
damaged or a partition has never been created.

Windows system caching
Windows reserves a specified amount of volatile memory for file system operations. This
is done in RAM because it is the quickest way to do these repetitive tasks.

Windows system records

The Windows registry keeps track of almost everything that happens in windows. This
enhances performance of the computer when doing repetitive tasks. Over time, these
records can take up a lot of space.
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